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Copyright
Copyright © 2017 Stratasys Ltd. All rights reserved.

This documentation contains proprietary information of Stratasys Ltd. This information is supplied solely to assist authorized
users of Stratasys J750 3D printing systems. No part of this document may be used for other purposes.

The specifications on which this document is based are subject to change without notice.

Trademarks

Stratasys, Objet, FullCure, PolyJet, J750, Connex, GrabCAD Print, GrabCAD Polylet Server are trademarks of Stratasys Ltd.
and/or its subsidiaries or affiliates and may be registered in certain jurisdictions. All other product names and trademarks are
the property of their respective owners..

FCC Compliance

The equipment referred to in this guide has been tested and found to comply with the limits for a Class A device pursuant to
part 15 of the FCC rules. These limits provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. Stratasys 3D printing systems generate, use and can radiate radio-frequency energy
and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-DUPCAB.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification to this equipment.
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it must be sent to appropriate
[Pa facilities for recovery and recycling. For information about proper disposal, check your purchase contract, or contact the
supplier of the equipment.

Limitation of Liability

The product, software or services are being provided on an “as is” and “as available” basis. Except as may be stated
specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any kind, whether express or implied,
including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose and non-infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental, special, consequential or
exemplary damages, including but not limited to, damages for loss of profits, goodwill, use, data or other intangible losses (even
if Stratasys has been advised of the possibility of such damages), resulting from: (i) the use or the inability to use the product or
software; (ii) the cost of procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software or data; (iv) statements
or conduct of any third party; (v) any other matter relating to the product, software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they are based are subject to
change. Stratasys Ltd. may, at any time and without notice, make changes to this document. Stratasys Ltd., for itself and on
behalf of its subsidiaries, assumes no liability for technical or editorial errors or omissions made herein, and shall not be liable
for incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration of data,
delays, or lost profits or savings arising from the use of this document.
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Stratasys J750 User Guide 1 About This Guide

Using This Guide

This user guide provides instructions for installing, operating and maintaining
J750 3D printing systems. It explains how to use features, and provides
practical examples to guide you as you use the system.

The text and figures in this guide are based on the J750 3D printer, software
version 85.1.0.

This document is meant to be used with J750 3D printers, running software
version 85.1.0.

This guide assumes that—

« all the hardware, software, and network components of your J750 system
are installed, configured, and operating correctly.

« the operator has a working knowledge of the Windows® PC platform.

For More Information

DOC-08040 Rev.D

Visit www.stratasys.com to download additional documents for this printer,
including documents in other languages. Also available on this site: details
about consumables and support contacts.

If you have any questions or comments about the way information is
presented in this document, or if you have any suggestions for future editions,
please send a message to c-support@stratasys.com.
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1 About This Guide

Terms Used in This Guide

Build tray

Cleaning fluid

Client/user workstation

Connex™

Digital Material

Digital Material Mode

GrabCAD Print
Mixed part
Mixed tray

Model material

Printer computer

Printer interface

Printer software,
printer-control
application
Resin

STL

Support material

DOC-08040 Rev.D

In the print preparation application: The surface displayed on
the screen that represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing material feed tubes and the printing block,
used to completely remove Model and Support material from
the system before loading another type of material in the
printer and before long-term shutdown. The cleaning fluid is
supplied in material cartridges.

The workstation on which software is installed for preparing
build trays for production on PolyJet printers. (There is no limit
to the number of client workstations.)

The technology of printing models by jetting multiple materials
simultaneously from the print heads. This technology enables
J750 printers to print in Digital Material mode.

Combinations of model materials fabricated in the printer from
the basic model materials installed.

The printer mode used to print a job using two or more
different model materials. (This mode can also be used to
eliminate the need for performing the Material Replacement
procedure when printing with a single model material.)

A software application for preparing print jobs on a variety of
3D printers, including the Stratasys J750 printer.

Models whose parts are printed using more than one model
material.

A build tray containing objects, each of which is designed to be
printed using a different model material.

Material used for building models.

The computer inside the J750 printer that operates it.

The GUI (graphical user interface) used for controlling the
J750 printer.

Software running on the computer inside the J750 printer, that
controls all printer operations.

The base substance from which photopolymer printing
materials are made for use in Stratasys PolyJet printers.

A file used for printing 3D models.

Material used for supporting the structure of models during
production.
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Stratasys J750 User Guide 2 Safety

Safety Features

Stratasys 3D printers are designed to comply with CE and FCC
standards. They are equipped with the following safety features:

Cover Interlock Switch The power supplied to the UV lamp(s), the tray heater and the
motion motors is turned off when the cover is opened.

& Warning

Do not defeat (override) the interlock switch. Doing so could
result in serious personal injury. If the interlock switch does not
function correctly, do not use the printer, and contact your service
provider.

Safety Lock The cover is locked while the printer is working. If you do
manage to lift it, the UV lamps and the motion motors turn off.

Warning

Do not defeat (override) the safety lock. Doing so could result
in serious personal injury. If the safety lock does not function
correctly, do not use the printer, and contact your service provider.

The transparent section of the cover blocks harmful UV
radiation, allowing the operator to view the model as it is being
made.

UV Screening

uv
screen

Figure 2-1 Front view of the Stratasys J750 printer

The power to the printer is turned off in case of electrical
overcurrent.

Circuit Breaker

Note: The circuit breaker is only accessible to service
personnel.
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Stratasys J750 User Guide 2 Safety

UV-Lamp Overheating The power supplied to the UV lamp and the motion motors is

Protection turned off if the temperature around the lamp reaches 90°C
(194°F). A label on the UV-lamp cover indicates if the
temperature has exceeded 65°C (150°F).

Grounded Chassis The chassis of the printer is grounded, to prevent electrical
shock.

Note: The power outlet must be properly grounded, in
accordance with the local electric code, to provide this
protection.

If the J750 3D printing system is not used as specified in this guide, the safety
features may not provide adequate protection.

Symbols and Warning Labels

This following table lists the warning labels located on or in J750 printers.

Warning Symbol Meaning Location Comments
Hazard (general) | Onthe name plate on the | Read the instructions in
back of the printer. this document before

operating the printer.

Hot surface On the print block. Risk of burns. Do not
touch this surface after
printing.

High voltage Near the UV lamp Risk of electric shock.

connectors.

Near the power-supply
enclosures.

Ultraviolet Near the UV lamps. Risk of injury from
radiation ultraviolet radiation.

DOC-08040 Rev.D 2-3
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Safety Guidelines

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the system. If the system is not operated as specified,
the user's safety may be compromised.

Printer >
Installation

>

Printer >
Operation

Y

YV VY

Installation and removal of the printer should only be done by qualified
service personnel.

Connect the printer (and the UPS unit) to the electric outlet using a power
cord that is safety-certified.

The electric outlet should be easily accessible, near the printer.

Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose the
operator to serious danger from electric shock.

The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:

“The machine must be connected to a grounded power outlet.”

O FI: Laite on liitettava suojakoskettimilla varustettuun pistorasiaan.
O NO: Apparatet ma tilkoples jordet stikkontakt.

O SE: Apparaten skall anslutas till jordat uttag.

O DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som
giver forbindelse til stikproppens jord.

Leave a minimum of 15 centimeters between ventilation openings and
walls or other objects.

The printer should only be operated by persons trained by a Stratasys
customer-support representative.

All persons operating or maintaining the printer should know the location
of first aid and emergency equipment and how to use it. Never block
access to this equipment.

Keep fingers and other body parts clear of the printer cover when closing
it.

Never attempt to open the printer cover while it is working.
Never override the interlock safety switch.
If the interlock safety switch ever fails, do not use the printer.

Several parts of the printer remain extremely hot even after it has stopped
operating. Avoid touching the UV lamps and the print block.

UV Radiation = The UV lamps used in the printer emit dangerous radiation.

>

DOC-08040 Rev.D

If the UV lamps remain on when the printer is open, do not stare directly
at the UV light. Shut down the printer and call your Stratasys service
provider.
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Printer > Service operations should be performed only by qualified personnel who
Maintenance have been instructed in relevant safety precautions.

> Notify co-workers and those who have access to the J750 system before
beginning non-routine and hazardous work.

% Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

Model and Model e}nd Support materials are made -of chemical substanges. Although

Support precautions must b.e taken when handling these materials dl}'ectly, all Model

Materials and Support materials used by the J750 system are handled in sealed
cartridges. Normally, operators of the printer should never be directly exposed
to hazardous materials. In the unlikely event of a leak or spill, follow the
instructions that are included with the printing-material cartridges used.

> Store Model and Support materials indoors, in a dry area with adequate
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

> Keep Model and Support materials away from areas where food and drink
are stored, prepared and consumed.

> Uncured printing material is considered a hazardous substance, requiring
certain precautions when directly handling it. To prevent skin irritation,
wear neoprene or nitrile gloves. If there is any chance that Model and
Support materials might splash into the eyes, wear safety goggles.
Prolonged direct contact with printing materials can cause an allergic
reaction.

> When handling UV-cured models that may not be completely cured on the
surface, common latex gloves are adequate.

> To prevent respiratory irritation, ventilate areas where Model and Support
materials are used. If the printer is not equipped with an exhaust duct, the
room ventilation system should replace the air at least 20 times per hour.

> (Clean up Model-material and Support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl alcohol
(IPA), followed by soap and water. Dispose of the absorbent material in
accordance with local regulations.

> Do not wash contaminated clothing at home; clothing should be
professionally laundered.

> Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing material
may re-expose the user when these items are worn.

DOC-08040 Rev.D 2-5
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UV Lamps

DOC-08040 Rev.D

UV lamps used by the printer to cure printing materials contain a small
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling
mercury vapor, and ventilate the room. If the lamp ruptures (breaks) during
operation, leave the room and ventilate it thoroughly for about 30 minutes.

Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that prevents
the generation of mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container. Dispose of the container in accordance with
applicable regulations.
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First Aid for Working with Printing Materials

Contact with
Skin

Contact with
Eyes

Ingestion

Inhalation

DOC-08040 Rev.D

In general, try to avoid direct contact with uncured printing material. If skin
or eyes come into contact with it, wash the area immediately and thoroughly
with water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing materials
contains important safety information. Keep this in an accessible place where
these materials are used and stored.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

> Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

> Do not use solvents to clean skin.

> If large areas of skin have been exposed, or if prolonged contact results in
blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

> Avoid the accidental transfer of printing material from the hands to other
areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.

Wearing contact lenses when handling liquid printing materials is not
recommended. If the liquid splashes into the eyes when contact lenses are
worn, immediately remove the lenses and flush the eyes with water.

> (Clean and disinfect the contaminated lenses.

> Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system. If
respiratory irritation occurs, expose the victim to fresh air immediately.

> If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

> Seek medical attention immediately.
> Keep the victim warm but not hot.
> Never feed anything to an unconscious person.

> Oxygen should be administered by authorized personnel only.
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Waste Disposal

Printing
Materials

UV Lamps
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Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste (uncured
printing material).

> When removing the waste container from the J750 printer, wear
neoprene or nitrile gloves.

> To prevent liquid waste from splashing into the eyes, wear safety goggles.

> Liquid waste from the J750 printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and disposed
of in a manner that prevents human contact with it and contamination of
water sources.

> Empty Model-material and Support-material cartridges contain residue of
their contents. Some leakage of this residue may occur through the broken
cartridge seal. Therefore, handle and store empty cartridges with care.

> Do not attempt to reuse empty cartridges, and do not puncture them.

> Dispose of used cartridges and waste containers in accordance with local
regulations.

> Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

UV lamps used by the printer to cure printing materials contain a small
amount of mercury, and are considered “Universal Waste.” Recycle or discard
used lamps in accordance with applicable regulations.

Broken lamps:

After ventilating the area, use protective gloves and carefully remove spilled
mercury with a method that prevents the generation of mercury vapor, such
as a syringe, packing tape or paper. Place the broken lamp, mercury and
contaminated materials in an air-tight, non-metallic container. Dispose of the
container in accordance with applicable regulations.
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The advanced capabilities of J750 3D printing systems are made possible by
technology specially developed by Stratasys for printing models
simultaneously with up to six different Model materials.

You can achieve the following results when printing 3D models on the J750
printer:

« You can streamline and economize the process of producing models.

O Printing models made from different materials on the same build tray
(“mixed tray”), in the same print job, eliminates the time-consuming
need and expense of loading another material, flushing the system, and
sending a separate job to be printed.

O Alternating print jobs that use any of the Model materials (or material
combinations) loaded similarly does not require material
replacement—again, saving time and expense.

« You can print objects with combinations of basic materials (digital
materials), enabling you to choose from a wide range of possible
mechanical properties—from flexible to rigid.

« You can print parts (shells) of the same model—simultaneously—with
different materials (or material combinations)

+ You can print objects that have a “coating” made from a different material
than the main part of the object.

« You can mix any combination of base materials, resulting in an extremely
wide range of available colors.

« If you designate colors for parts of a model at the design stage (with CAD
software) and save the model as a VRML file, the parts are automatically
assigned appropriate material combinations in GrabCAD Print for printing
the model with the desired colors.

« You can choose the preferred Support material for your needs.

GrabCAD Print supports many 3D CAD file formats, eliminating the need to
convert them to STL files. GrabCAD Print also automatically repairs damaged
files before sending them to the printer.
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Work Configurations

Source Files

DOC-08040 Rev.D

The Stratasys J750 3D printing system can be set up as a single-station system
or as a multi-station system. When connected to a local computer network,
the system can serve multiple users. In such configurations, each user (client)
prepares files for production. A software service, installed on the printer
computer, controls the printing.

Figure 3-1 shows the printer set up in a multi-client configuration.

Client

| waorkstations

printer

Figure 3-1 Multi-client network configuration

J750 printing systems produce three-dimensional models designed with most
CAD tools and some other 3D applications.

GrabCAD Print supports STL and, VRML files, and, in addition, native CAD
formats from these programs: Creo, SOLIDWORKS, NX, CATIA and
Inventor. To see the complete list of file formats supported by GrabCAD
Print, go to: help.grabcad.com/print/file-formats.

J750 systems feature the capability of producing different types of model files
simultaneously.
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Printing Materials

J750 printers produce models by jetting thin layers of printing materials on
the build tray, until the complete model is formed. Two types of material are
used in this process:

« Model material—which makes up the finished model

« Support material—which fills gaps and spaces in the model during
printing, and is removed after printing

% For up-to-date information about PolyJet printing materials and their
properties, go to www.stratasys.com/materials/polyjet.

Materials used for printing models with J750 printers are made of resins,
which are composed of reactive monomers and oligomers. Although printing
materials are supplied in sealed, UV-proof cartridges, care must be taken
when storing and handling them. Follow these guidelines to protect operators
and the environment, and to ensure optimum results.

Storage

« To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances (such
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet
printing materials.

« When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

« Store material cartridges indoors, in a dry area with adequate ventilation,
between 15—25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to
heat or flames, cartridges might burst or ignite.

« Signs of premature polymerization in material cartridges include bulging,
leaking, the emission of heat, and unusual odor. Exposure to heat can
cause resin to gel in the cartridges.

» Make sure that material cartridges are stored in accordance with all local
regulations and other applicable requirements.

Shelf Life Materials used for producing models have a limited shelf life. The expiry date
on the label is valid when properly stored in an undamaged, unopened
cartridge. Always rotate your stock, so that the cartridge with the earliest date
is used first.

Exposure to If printing mate'rials are not in their sealed cartri.dg.es, make sure to shield

Light them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.
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Safety Before being cured, resins are hazardous materials. To prevent possible health
Considerations hazards, follow these precautions regarding printing materials:

« Do not expose to flames, heat or sparks.
« Prevent contact with skin and eyes.

« Ventilate areas where they are handled.
» Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

% You can find more safety information about resins in:

« "Safety Guidelines" on page 2-4
« "First Aid for Working with Printing Materials" on page 2-7

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.

Disposal

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
the J750 3D printer. Use ventilation or air-conditioning systems, if necessary,
to keep the work area within the following ranges:

* 18°—25°C (64°-77°F)

» 30%—70% relative humidity

Workstation Requirements

GrabCAD Print is an application for preparing and and managing print jobs
on the Stratasys J750 printer (and on other supported 3D printers). To
download GrabCAD Print, go to: help.grabcad.com/print/sign-up.

To see the requirements for client computers running GrabCAD Print, go to:
help.grabcad.com/print/system-requirements.

In addition to GrabCAD Print on client computers, GrabCAD PolyJet Server
is required on the printer computer. This is the program that controls the
actual printing. To download GrabCAD PolyJet Server, go to:
help.grabcad.com/print/j750.
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Printer cover

Materials cabinet

Figure 4-1 The Stratasys J750 3D Printer

Starting the Printer

& Caution

Do not attempt to operate the printer before being trained by a Stratasys
Customer Support representative.

« Observe all safety warnings and follow the safety guidelines described in
Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 4-2 Main power switch and cable
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2. After the printer-control computer boots, log in to Windows and launch
the printer-control program:

%{ A HASP plug containing a valid product activation key is required on the
printer computer. This is supplied during printer installation or upgrade. If the
application does not open and a HASP message appears, contact your
dealer or Stratasys Customer Support.

All monitoring and controlling of the printer is done from this interface.

19 Oct 2015 18:33

Cabinet A Cabinet B

FullCure705 FullCure705
Printer mode

Support materials
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Figure 4-3 Stratasys J750 interface
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Loading Model and Support Cartridges

J750 printers use up to 12 cartridges of Model material and up to four
cartridges of Support material, each weighing 3.6 kilograms when full. A
graphical representation of the cartridges loaded and their current weight
appears in the printer interface (see the figure on the previous page).

% The material cabinet contains cartridges of printing material. For this purpose,

DOC-08040 Rev.D

an RFID module is built into the cabinet. Tampering with this module will
render the printer inoperable and may void Stratasys warranties and service
contracts.

Important: [f you need to replace the Model material currently installed with
another type, see "Changing the Printing Material" on page 4-11. Otherwise,
make sure to replace the Model cartridge with one containing the same type of
material.

To load Model and Support material:
1. Open the doors of the material cabinet.

2. Load Model and Support cartridges into their respective compartments.
You should feel some resistance, as a needle pierces the cartridge.

3. Check the printer interface to make sure that the new cartridge is detected
and that its weight is displayed (see the figure on the previous page).

4. Close the material cabinet.

Tips about loading and replacing material cartridges:

« You can load partially used cartridges, provided that they contain more than
100 grams of material.

« You can replace material cartridges either before or during printing.

« If printing stops for an extended time before you replace a material cartridge,
the printer may go into Standby or /dle mode. If this happens, see "Resuming
Production After Printing has Stopped" on page 4-9.

« You can replace a partially used cartridge to avoid the need for replacing it
during printing.

« The cartridge type is automatically detected by the printer. If you replace a
cartridge containing different Model material, a message appears
recommending that you run the Material Replacement wizard to flush out the
old material.
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Producing Models

Preparing the
Printer

DOC-08040 Rev.D

Models can be printed after they are arranged on a virtual build tray in the
GrabCAD Print application. For information about preparing model files for
printing, see the GrabCAD Print online documentation.

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
"Pattern Test" on page 4-29).

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not,
remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

Caution

Use protective gloves when cleaning the build tray, and be careful of the
sharp edges of the scraper blade.

2. Make sure that there is sufficient Model and Support material loaded, as
indicated on the printer interface (see the figure on page 4-3). You may
want to replace the cartridges of Model and Support material currently
loaded in the printer to avoid the need for replacing them during printing.

For installing material cartridges and replacing empty ones, see "Loading
Model and Support Cartridges" on the previous page.

For changing the type of Model material currently loaded, see "Changing the
Printing Material" on page 4-11.

4-5
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You can monitor printer status by switching the printer interface display. To
do this, click the display toggle button on the printer interface screen.

StrataSVS 180ct2015  18:33
Temperature
behind print eads (°C) {
block o2 S
Temp. of each
" fzo M 70 70 W 70 [ 70 W 70 70 i 70 I head
block ) ( Support/Model
Heaas Lot (EDEDEICIEIEI 3 ED material in print
Y
block reservoir
Waste weight— SEMELACONES 9000

Ambient(°C) 43 [ CET ERVETATI ] 12.2
Chamber temp. = —
p UV Lamps L . R Pre Heater 62 \ iSyStlem vacuum
eve

/

Left and right UV 7 Temp. of
lamps | material
Display toggle‘ STRATASYS J750™ pre-heaters
button
Printer set to
offline mode
(red)
Figure 4-4 Printer status
Starting To begin printing:
Printing > On the printer interface, click the red button to switch the printer to

online mode.

The color of the button changes from red to green (see the figure on
page 4-3). If there is a job in the printing queue, it is sent to the printer.

When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality. (See
"Routine Maintenance Schedule" on page 4-25.) Maintenance notifications
can be disabled/enabled from the Options menu.

In the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

« The print block is heated.
» The UV lamps are powered and they warm up.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model and
Support material in the supply cartridges, printing proceeds automatically
until the job is finished.

The J750 printer uses up to six different Model-material cartridges to produce
models. In addition, two Support-material cartridge are required. If additional
cartridges are installed and they are not immediately needed for printing, the
printer interface indicates this (see "Printer Interface Color Key" below).
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Printer
Interface
Color Key
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

» Green—suitable/ready for printing
For example, in Figure 4-4 on the previous page:

O Heads (°C)—The heads have reached the temperature required for
printing models.

O Ambient—The ambient temperature of the printing chamber is within
the acceptable range.

O Heads Liquid—The level of Model and Support material in the
print-block reservoir is OK.

O Heads Vacuum—The vacuum level in the system is within the
acceptable range.

O Pre-Heater—The Model and Support resins need to be heated before
being supplied to the print block. The temperature has reached the
acceptable range.

» Red—not suitable for printing (or indicates a warning)
For example, in Figure 4-4 on the previous page:

O Waste—The weight of the waste container is 9000 grams, more than
allowed when beginning a print job. (See "Replacing the Waste
Container" on page 4-98.)

* Blue—not ready
For example, in Figure 4-4 on the previous page:
O UV lamps—The UV lamps are not on.

The color of the material cartridges displayed in the printer interface indicates
which cartridges are active for the current (or next) print job.

For example, in Figure 4-3 on page 4-3:
« Blue—active cartridge
» Gray—reserve cartridge

4-7
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Printing The printer interface screen changes when you send a print job to the printer,
Indicators if the printer is on line:

« The mode changes from Pre-print to Printing.

« The specific activity being performed is shown in the “current activity”
field.

« Current job-printing information is displayed.

« The printing progress bar is displayed.

« The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

R s
stratasvs 19 Oct 2015 18:33

Cabinet A Cabinet B
VeroBlue VeroBlue FullCure705  FullCure705

Printer mode — @  Printing
M3-L M3-R SH-L SH-R

Print Time 00:20:01
400 gr 400 gr 500 gr 500 gr

Job information
VeroCyan VeroCyan VeroBlack VeroBlack

Height 4.73mm of 29.37mm
d — M2-L M2-R Mé6-L M6-R
Current activity ————=—— Printing Pass 1
400 gr 400 gr 400 gr 400 gr
Slice 163 of 1013 (16.1%) VeroClear  VeroClear VeroYellow VeroYellow
Job information
Previous job last slice: 163 LA ~LE L= —ER
400 gr 400 gr 400 gr 400 gr
FullCure705 FullCure705 VeroWhite  VeroWhite
SL-L SL-R M4-L M4-R : |
= Progress bar

500 gr

STRATASYS J750™

Pause button

Stop button

Figure 4-5 Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, the print manager stops sending slices
to the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you do not replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the print manager in GrabCAD Print.

After printing stops, the printer goes into Standby mode, when heating of the
print heads is reduced. About 10 hours later, the printer goes into /dle mode,
when heating of the print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see the figure on page 4-

3).
The button changes from red to green.

2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

3. In the Manager screen of GrabCAD Print, click Resume E]

4. In the job-preparation application, make sure that the correct slice
number is entered in the dialog box.

Frint Job l:-Impeller GrabCAD

ast printed slice 168

Figure 4-6 Slice confirmation in GrabCAD Print
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Printer mode

Print Time 00:00:43

Height 5.29mm of 77.88mm

Slice 168 of 2782 (6.8%)

Previous job last slice Last slice printzd

Figure 4-7 Printer interface after interrupted printing

5. If, for any reason, the correct number does not appear in the dialog box,
enter the number and click OK.

You cannot continue printing the model if:

« The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the confirmation dialog box.

 There was a relatively long interruption in printing, even if the “last slice”
and indicators are correct. The part of the model already printed may
deform or shrink, and there might be a visible difference between it and
the newly printed part. The effects of a printing stoppage on a model
depend on the model size and structure, Model material used, ambient
temperature and the length of the stoppage.

If you cannot continue printing:
1. Cancel the job in GrabCAD Print.
2. Remove the partially printed model from the build tray.

3. Click! to resend the job to the printer.

%{ You can stop printing from either the printer interface or from GrabCAD Print.

* After clicking the Stop button in GrabCAD Print, you can resume printing
from GrabCAD Print or from the printer interface.

* After clicking the Stop button on the printer interface, you can resume
printing only from the printer interface.

* After clicking the Pause button in the printer interface, you can resume
printing only from the printer interface.
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Changing the Printing Material

Before producing models using a different type of printing material than is
currently installed, run the Material Replacement wizard to flush the print
block and feed tubes.

After using the wizard to change the Support material and certain Model
materials, Head Optimization is required before printing models.

%{ You should carefully plan printing models with different Model materials to
avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are replacing
one or more Model cartridges.

The Material Replacement wizard suggests the best slot locations for placing
different material cartridges, based on the materials currently in the system.
This ensures minimum flushing of materials currently loaded.

To replace the printing material with the wizard:
1. Start the Material Replacement wizard from the Options menu.

File Options Help

Go to Tray Upper Position

Go to Purge Position 24 Oct 2017
Wipe

Go To Head Inspection

Cabinet B

Go to Tray Lower Position
Execute Purge Sequence

Pattern Test
Dynamic Mozzle test

Wizards Material Replacement
Built In Tests... Head Filling Calibration
Cleaning

UV Calibration

Maintenance Counters...

Collect Service Data
UV Lamp Replacement

Head Alignment
Previous job last slice: 0 Head Optimization

Load Cell Calibration

Shutdown

Figure 4-8 Starting the Material Replacement wizard
2. In the opening screen, click Next.

3. If the printer cover is not closed, a screen appears, prompting you to close
the cover. Confirm that it is closed and click Next.
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4. Choose the configuration for producing models:

O 6 materials
O 3 materials

Material Replacement Wizard

Printing mode
@ B materials (High Mix / High Quality)

(©) 3 materials (High Speed)

Required materials
Mote: Cartidge positioning in material cabinet is determined automatically.

Tango+ Both cartridges
VeroPureWht Both cartridges
VeroBlack Both cartridges
VeroCyan Both cartridges
VeroMgnt Both cartridges

VeroYellow Both cartridges

Support | FullCure705 @234 carridges

'Full’ provides you with exact color immediately.
'Economy’ enables a faster material replacement cycle.

’ 2 Help ] ’Advanced Settings...]

) Full
7 Full
7 Full
7 Full
) Full

7 Full

Material Replacement Options

@ Economy
@ Economy
@ Economy
@ Economy
@ Economy

@ Economy

Figure 4-9 Material Replacement Options
6 Materials

Each of the three Model print heads is loaded with two different

materials.
Support Support TangoPlus VeroWhite VeroYellow
S S M6 M5 M4 M3 M2 M1
Lt | L2 | L5 | L4 |
I I | ]
Support print heads Model print heads

Figure 4-10 Six materials loaded in the print heads

O Once the materials are loaded, you can print with any single material,
or with a combination of them. High-speed printing is not available,

but high-quality models can be printed.
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3 Materials
Both sections of eachModel print head are loaded with the same material.

Support Support VeroWhite VeroWhite VeroYellow | VeroYellow
S S Mé M5 M4 M3 M2 M1
L1 | L2 | L | L4 |

| L | ]
Support print heads Maodel print heads

Figure 4-11 Three materials loaded in the print heads
O Up to three Model materials are available, with high-speed printing.

. In the Required materials section of the wizard screen, select one or more

replacement materials cartridges.

. For Model materials, select Both if you need to load two replacement

cartridges.

Loading one replacement cartridge is more economical because it
potentially requires less flushing of material currently in the system.
However, when one cartridge is not sufficient, loading two cartridges
enables continuous printing until the print job is completed. When one
cartridge empties and the other one is being used, you can replace the
empty cartridge with a new one.

. For Support material, select the number of cartridges to replace (2, 3, or

4).

Note: Atleasttwo Support material cartridges are required.

. If the color or mechanical properties of the first printed models are

unimportant, you can change the Model materials without flushing out
the current materials. To do so, continue with "Changing Model Materials
Without Flushing" on page 4-16.

. To flush out material currently in the system, choose the flushing cycle

that fits your needs:

%{ The default flushing cycle is the one used for the last material replacement.

DOC-08040 Rev.D

O Economy. This cycle can be used when replacing a light-colored Model
material with a darker material (such as TangoBlack™ or VeroBlack™)
or if the exact color of the printed models is unimportant. Use this
cycle when replacing cleaning fluid with any Model material.

The wizard flushes the system with the minimum amount of material
needed to ensure that models have the mechanical properties of the
new material.

O Full. Use this cycle when the printed models must have the exact color
of the new material.
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The wizard thoroughly flushes the feed tubes and print heads needed
for printing, based on your selections in the previous screens.

There are additional settings that you can select for special purposes (see
"Advanced Settings"). If necessary, click Advanced Settings before clicking
Next.

10. Click Next to begin the material replacement process in the printer.

The Cartridge positioning screen appears, showing you the new location
of all cartridges in the material cabinet.

Cartridge Positioning and Process Progression
Inzert the new malenal carridge a8 shown balow, and click "Start " )
® Left Right cabLln'&AlcT_hlnR’lB Left Right

M3 VeroBlue VeroBlue v swpot  FullCure705 @ FullCure705 v |

M2 VeroCyan (x] VeroCyan v M6 VeroBlack & VeroBlack v
M1 VeroClear Fiis Movariaae (@) Ms VeroYellow ¥ VeroYellow (@)

support  FullCure705 ¥ FullCure705 /A M4 VeroWhite ¥ VeroWhite Vv

[ 0%
This process will take approximately 4 minutes

Figure 4-12 Cartridge placement
Symbols:

¥ The correct cartridge is in this slot.
® No cartridge (or the incorrect cartridge) is in this slot.

“ The cartridge in this slot has insufficient weight to complete the material
replacement process.

© The expiration date of the cartridge in this slot has passed.

11. Replace material cartridges as necessary, according to the instructions in
the wizard screen.

12. Click Start.
13. Read the warning message, and click OK.

%{ If you continue, you must complete the material replacement process before
you can produce models. To replace material cartridges at another time, click
Cancel. If you continue (by clicking OK) and you do not complete the process,
you will need to run the wizard again before producing models.
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%

If you continue, you must complete the material replacement process before
you can produce models. To replace material containers at another time, click
Cancel. If you continue (by clicking OK) and you do not complete the process,
you will need to run the wizard again before producing models.

I N Wizard Completed
Printer's current configuration
M ® Left Right Left Right

|

| — M3 VeroMgnt VeroMgnt Support  FullCure705 FullCure705
M2 VeroWhite VeroWhite M6 RGD535 RGD535
M1 VeroYellow VeroYellow M5 VeroCyan VeroCyan

Support  FullCure705 FullCure705 M4 RGD515 RGD515

Printing mode: High Mix / High Quality
stratasys

— = ————
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Figure 4-13 Final wizard screen

14. In the final wizard screen, click Done.
The printer-control application is automatically updated, and it restarts.
When it opens, the interface displays the new material(s). The interface in
the job preparation application is also updated, and it displays the new
material(s).

15. Inspect the area around the purge unit and clean it, if necessary.

Caution

If necessary, the cartridges can be disassembled for recycling. If this is done,
protect the person handling the cartridges from direct exposure to uncured
resins.

Before printing models, you need to run the Head Optimization wizard in
these cases:

« after changing the type of Support material (SUP705/706)

« after replacing Vero with ABS-like or Agilus30 Model materials (and the
reverse)

See "Optimizing (Calibrating) Print Heads" on page 4-47
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Changing Model Materials Without Flushing

You can change the Model materials without flushing. Use this option when
the color or mechanical properties of the printed model are unimportant.

To change Model materials without flushing:

1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection and click
Apply.

Material Replacement Wizard

P N Advanced Settings

Cartridge positioning:
() Automatic slot selection (Recommended)
@ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

[] Enable flush again” options

Stra lasvs This selection applies to this use of the wizard only.
(o) e |

Figure 4-14 Manual slot selection

3. When the Material Replacement Options screen opens, select the Replace
materials without flushing check box and click Next.

Material Replacernent Wizard
Material Replacement Options
Printing mode
@ & materials (High Mix | High Quality)
A |
3 matenals (High Speed) [
Required materials
Support | FullCure705 - v Both cantridges
ME _'\-'smBIanlc = ¥ Both carridges
B -
M5 MeroYellow - ¥ | Both carindges
M4 VieroWWhite - ¥|Both cartnidges
M1 VeroBlue - +| Both carridges
A M2 | VeroCyan - ¥ Both carfridges
M1 VeroClaar =) ¥|Both carindges
Suppert | FullCure705 - | Both carindges
"Full” provides you with exact color immediatsly. — T e
'Economy’ enables a faster material replacement cycle Q\i Replace matenals without flush '"?_,)
| T Hep | | idvanced Settings.. | | X Cancal | Newt 3= |

Figure 4-15 Replace materials without flushing
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4. In the confirmation message that appears, click Yes to continue.

i

Confirm @

| You have selected to replace the materials without
¥ running the Material Replacernent Wizard,

Mote that this bypass is not recommended and will not
flush the systern with the new materials.

Are you sure you want to continue?

-

Figure 4-16 Replace without flushing confirmation message

5. In the Cartridge Positioning and Process Progression screen, click Start.

Material Replacement Wizerd
Cartridge Positioning and Process Progression
Insart the new materal cartrcige as shown below_and click "Start
Cabinet A | Cabinet B
@ Lefi Righ L R L R @ Right
M3 VeroBlue L VeroBlue w3 suport FullCure705 FullCure705
M2 VeroCyan W VeroCyan W M2 ME& VeroBlack v VeroBlack W
M1 VeroClear W VeroClear . MS VeroYellow VeroYellow
3
Suppert FullCure 705 * FullCure7 05 e M4 VeroWhite v VeroWhite
—_—
-
RepaCEmEnt DrogrEss —
% |
[ 2 X Concel | [ € Previss

Figure 4-17 Cartridge Positioning and Process Progression screen

6. Read the Warning message that appears, and click OK to continue.

’Warnl'ng @

l 3 Beyond this point, selecting 'Cancel' or
== changing/remuoving any of the material cartridges will
abort the wizard and disable printing.
Resurning printing will cnly be possible after completion
of this Wizard.
Do not remove any material cartridges from the printer
during this process,

[ QK ] [ Cancel

.

Figure 4-18 Warning message
Material replacement begins.
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Advanced
Settings

Positioning
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The Advanced Settings dialog box enables you to configure the Material
Replacement wizard for special purposes. If necessary, click Advanced
Settings in the Material Replacement Options screen before clicking Next.

By default, Automatic slot selection determines the best slot locations for the
cartridges in the material cabinet, based on materials currently in the system.
This ensures minimum flushing of materials currently loaded.

Select Manual slot selection if—

« there is a special need to load cartridges in certain slot locations.
« you only want to change one of the cartridges in certain slot locations.

Some materials cannot replace certain other materials. If you attempt to do
so, the wizard notifies you.

To select the slots for the cartridges manually:
1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection, and click
Apply.

Material Replacement Wizard

Advanced Settings

Cariridge positioning:
Automatic slot selection (Recommended)

@ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

Enable "flush again” options

Stra tasvs This selection applies to this use of the wizard only.

2 Help [ € Cancel | [ app 3 |

Figure 4-19 Manual slot selection
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3. In the Material Replacement Options screen, select or clear the Both
cartridges check box for each slot, as required.

Note: When changing Support material, select at least two Support
material cartridge slots—one from A (either L or R) and one from B
(either L or R).

Material Replacement Wizard
Material Replacement Options
Printing mode
@ B materials (High Mix | High Quality)

.—_

3 materials (High Speed) u ir

Required materials

Suppert | FullCure 705 | Both canridges

. . L
MG | VeroBlack | ¥ Both cartridges o @ Full Economy
B - .
M5 | VeroYellow ) | Both carindges @ Full Economy
M4 | VeroWhite - Both cartridges |L T @ Full Economy
M3 | VeroBlue | ¥ Both cartridges @ Full Economy
A M2 | VeroCyan ) Both carridges (L | @ Full Econamy
M1 | VeroClear - | Both cartridges @ Full Economy
Support | FullCure?05 | Both carindges |L xi
'Full’ provides you with exact color immediately.
'Economy’ enables a faster material replacement cycle Replace materials without flushing
| % Hep | |Advanced setings.. | [ % cance | hew

Figure 4-20 Material Replacement Options (Advanced)

4. When a check box is cleared, a dropdown menu appears. Select L (left) or
R (right) to change the cartridge on the left or the right side only in that
location.

After clicking Next, the Material Replacement Options screen appears, but
now, each material selection box corresponds to one of the cartridge levels in
the material cabinet.

Printing mode
(©) & materials (High Mix / High Quality)

@ 3 materials (High Speed)

Required materials

Cabinet A | Cabinet B
L R L R

Support ’FuIICure?D5

M |

M5 ’VeroYeIIow

me |

M3 ’VeroBIack

M2 |

M1 [Fullcurs720

Support ’FuIICure?D5

Figure 4-21 Manual cartridge placement



Stratasys J750 User Guide 4 Operating and Maintaining the Stratasys J750 3D Printer

Additional The flushing cycle you select in the Material Replacement Options screen
Flushing Cycles determines how thoroughly to flush out material currently in the system.
After selecting the Economy cycle and completing the wizard, you might
decide that you require a more thorough flushing, to ensure accurate model
color. Or, you may notice that printed models are not satisfactory because
they contain traces of the previous material. If so, you can flush out more
material, so that the next models will be printed with pure material.

To perform additional flushing cycles:

> In the Advanced Settings screen, select Enable "flush again" options and
click Apply.

Material Replacement Wizard

Advanced Settings

Cartridge positioning:

@ Automatic slot selection (Recommended)

_ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

Enable “flush again” options

Stratasvs This selection applies to this use of the wizard only.
2 Help | € Concel | | sppb 3 | ||

Figure 4-22 Enable flush again options selected

The Material Replacement Options screen appears, where you can select the
material(s) you need to flush again.
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Keeping the Printer in Idle Mode
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Between printing jobs, the J750 printer can be left unused for up to one
week. If the printer will not be used for more than a week, use the Shutdown
wizard to automatically perform the procedures that must be done before
turning off the printer (see "Shutting Down the Printer" on the next page).

When the printer stops producing models, the printer software automatically
reduces the temperature of the print heads, as follows:

After printing stops Mode Change in heating of print heads
first 15 minutes Standby 1 no change

next 1 minute Standby 2

after Standby 2 Idle heating stopped

Note: The printer mode is indicated in the upper left of the printer interface
screen (see the figures on pages 4-3, and 4-8).

If, after printing a job, you know that the printer will not be used for 16
minutes or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into Idle mode:

> From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the J750 printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this mode—
with the cover closed—for up to a week. For longer periods, shut down the
printer by running the Shutdown wizard (see Shutting Down the Printer,
below).
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Shutting Down the Printer

You only need to shut down the J750 printer if it will not be used for a week
or more. Otherwise, the printer can remain on, in Idle mode.

%Z\ The Shutdown process flushes printing materials from printer components.
To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

To properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown wizard. Do not attempt to shut down
the printer by simply closing the computer interface (the printer-
control application), and never disconnect power to the printer
before completing this wizard.

& Caution

Not using the printer for an extended period without first running the wizard
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose
between a short shutdown procedure, and a more thorough procedure.

« Up to 30 days: The wizard empties the print block of Model and
Support material, to prevent leaks. This takes about 10 minutes.

» More than 30 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 75 minutes, and you must
be present to load a cleaning-fluid cartridge when instructed.

To run the Shutdown wizard:
1. Start the Shutdown wizard from the Options menu.

Shutdown Wizard

Shutdown Wizard

Gﬁ You can leave the printer in idle state for up to 30 days.

Use this wizard whenewer you want to shut down the
printer. Do not atternpt to shut down the printer by turning
off the printer computer, and newver disconnect power to
the printer before completing this wizard.

‘When shutting down the printer. you hawe two options,
depending on the length oftime the printer will not be
used:

-Upto 30 days.

Stratasvs - Mare than 30 days.

| x Lancel |

Figure 4-23 Shutdown wizard, opening screen
2. Click Next.
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3. Select the option corresponding to the length of time that the printer will
not be used—Iless or more than 30 days.

Note: Before selecting More than 30 days, make sure that cleaning-fluid
cartridges are available.

Shutdown Wizard

P o N Select Action

Shutclown the printer for:

@ Up to 30 days.

() More than 30 days [requires cleaning-fluid cartidges).

stratasys

Figure 4-24 Shutdown options
4. In the next screen, verify that the tray is empty and click Next.

Shutdown Wizard

L Check Printer

K Confirm before continuing:

[ The build tray is empty.

stratasys

’ x Lancel ] ’% Erevious]

Figure 4-25 Tray status

The shutdown procedure begins.

Shutdown Wizard

Shutdown in Progress

o

stratasys

Figure 4-26 Shutdown progress
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5. Follow the instructions until cleaning is completed.

6. When the final wizard screen appears, close the printer-control
application and shut down the printer computer.

Shutdown Wizard

Wizard Completed

L

You may now shut down the printer computer and turn off
power ta the printer.

stratasys
|

Figure 4-27 Final Shutdown wizard screen

7. After the printer computer shuts down, turn off the main power switch at
the back of the printer (see Figure 4-2 on page 4-2).
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Maintaining the Printer

Routine
Maintenance
Schedule
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Performing routine maintenance tasks is essential for getting satisfactory
results from J750 3D printers. Perform the tasks at specified intervals.

Frequency Task For More
Information
Before printing Clean the UV lamp lenses.
Before / after printing Check the UV lamp overheating indicator. | See "UV Lamp
Check " on
page 4-29.
Before / after printing Routine cleaning of: "Cleaning the
« print heads Print Heads,
Roller and
* roller surface —
i Wiper" on
* wiper page 4-32.

* build tray and surrounding area

Weekly

Clean the purge unit waste collector.

See step 11 of
"Cleaning the
Print Heads,
Roller and
Wiper".

Weekly

Perform the Pattern test.

See "Pattern
Test" on
page 4-29.

Weekly

Back up the printer's configuration files.

See "Backing up
the Printer
Configuration"
on page 4-31

Weekly

Restart the printer computer.

Weekly

Clean the roller waste collector.

See "Cleaning
the Roller
Waste Collector
and Inspecting
the Roller
Scraper" on
page 4-36.

Every 300 hours of

printing (A reminder
message appears.)

Calibrate the UV intensity.

See "Testing
and Calibrating
the UV Lamps"
on page 4-65.

Every 300 hours of

printing (A reminder
message appears.)

Optimize the print heads.

See
"Optimizing
(Calibrating)
Print Heads" on
page 4-47.
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Maintenance
Counters
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Frequency Task For More
Information
Monthly, and after Check the alignment of the print heads. See "Aligning
replacing print heads the Print
Heads" on
page 4-41.
Monthly Remove and clean the print-head splash | See "Cleaning
shield. the Print-Head
Splash Shield"
on page 4-45.
Monthly Clean debris from the Z-axis shaft with a
vacuum cleaner.
Monthly Inspect the exhaust system (duct, fan,
connections).
Monthly Calibrate the load cells. See

"Calibrating the
Load Cells" on

page 4-72.
Every 250 hours, after Flush the print-block heater. See "Flushing
changing from 6-material the Print-block
to 3-material printing mode Heater" on
(A reminder message page 4-73.

appears.)

Every 1500 hours of print-
ing

Replace the waste-pump tubes.

See "Replacing
the Waste-
Pump Tubes"
on page 4-77.

About once a year (as
necessary)

Replace the Vero PureWhite Material
Filter

See "Replacing
the Vero
PureWhite
Material Filters"
on page 4-81.

Every two years or every
3500 hours of printing

Preventive maintenance visit by service
engineer.

Contact your
Stratasys
service
provider.

The printer computer application records the dates and frequency for each
maintenance task. You can display the Maintenance Counters screen from

the Options menu.
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Go to Tray Upper Position F5
Go to Purge Position F&
Wipe F7
Go To Head Inspection F8
Go to Tray Lower Position F10
Execute Purge Sequence Fd4
Pattern Test

Dynamic Nozzle test

Wizards »
Built In Tests... Ctrl+ Alt+B
Maintenance Counters.., b

Collect Service Data F2

Figure 4-28 Selecting Maintenance Counters

If there is a maintenance task due, this is indicated on the main interface
screen.

& stratasys

Maintenance Required

Figure 4-29 Maintenance Required indicator
If this indicator appears, you can display the Maintenance Counters screen by
clicking on it.

The Maintenance Required indicator appears by default for most operator-
performed maintenance tasks. The check box under “User Warning” controls
whether or not it appears when a particular task is due.
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Wl Maintenance Counters (Hours) rz|
File  Units
Item Total Dated Warning Time User Warning

Tatal Printing time | ‘ | | | |

>3

P is Due | | ‘ | | ‘

&

Operator Maintenance

L Calibration

&

Heads Cleaning

=

HEU || |
Pattern Test | ‘ | |

B
“wiper Cleaning | [ ||

Head Alignment

&

Load Cell Calibration

]

[ |
[ |
[ |
[ |
Raller Bath Inspection | | ‘ | | ‘ Reset
[ |
[ |
[ |
[ |

Riestart Computer | [ || Fieset
Blade Replacement

Wiper Blade [ || | [ | [ FReset

Fioller Blade | N || [ Rea | O

Figure 4-30 Maintenance Counters screen

For maintenance tasks that are controlled by wizards, the dates and printing
times are reset automatically when the relevant wizard is run and completed
successfully. Manual maintenance tasks (for example, roller inspection and
wiper replacement) are reset by clicking the reset button in the screen.
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UV Lamp A heat-sensitive label is fixed to the UV lamp covers as a warning against

Check overheating. Its center changes from white to black if the temperature of the
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call
your service provider. As a precaution, it is recommended that you check the
label before and after printing.

Marmal

Cverheating
problem

Figure 4-31 Heat-sensitive label on UV lamp cover

%{ If the UV lamp continues to overheat, and the temperature around the lamp
reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the
UV lamp and the motors for the X, Y, and Z axes. In the unlikely event that this
occurs, the printer cannot be used until it is serviced by an authorized service
engineer.

Pattern Test The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the print
heads. Make sure, therefore, that you perform this test weekly, and whenever
you suspect a printing problem.

To perform the pattern test:

Make sure that the build tray is empty.

Prepare a sheet of pink paper, A-4 or Letter size.

In the printer, tape the pink paper to the surface left of the build tray.

B @b

Press F3, or open the Options menu and select Pattern Test.
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File” Options Help

Go to Tray Upper Position F5
Go to Purge Position F&
Wipe F7
Go To Head Inspection F8
Go to Tray Lower Position F10
Execute Purge Sequence F4
Pattern Test F3

Dynamic Nozzle test

Wizards 4
Built In Tests... Ctrl+Alt+B
Maintenance Counters... Shift+Ctrl+C
Collect Service Data F2

Figure 4-32 Selecting Pattern Test
5. Click Yes in the Confirm dialog box to begin.

Confirm rz|
=2

[ Yes l [ Mo ]

Perform Pattern Test?

Figure 4-33 Pattern Test confirmation
6. If the build tray is not clear, click No in the following dialog box.

Confirm f'5_<|

y  Is the build tray clear?
\_t/ (If you didk 'NO', the tray will be lowered.)

[ fes l [ Mo ]

Figure 4-34 Build tray (Z) level adjustment
This lowers the build tray, so that models on the tray are not damaged.
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The printer prints a series of lines on the test paper (see next figure).

Figure 4-35 Sample Pattern Test

7. Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area, indicates
that the quality of printing when producing models will be poor. If this is
the case, see "Improving Print Quality" on the next page.

Note: Acceptable model quality is subjective, and depends on the type and
scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.

Backing up the It is recommended that you periodically back up the printer's configuration

Printer files. In case of printer malfunction or the need to re-install the software on

Configuration the printer computer, parameters can be restored from the backup. The
backup also saves the printer's log and the calibration and maintenance
history.

To back up the printer configuration files:
1. From the Options menu, select Collect Service Data.

or—
Press F2.
Go to Tray Upper Position F5
-
Str‘ Go to Purge Position F&

Wipe F?
Go To Head Inspection F&
Go to Tray Lower Position F10

Execute Purge Sequence F4

Pattern Test F3

Dynamic Nozzle test

. Wizards 3

Built In Tests... Ctrl+Alt+B

Maintenance Counters... Shift+Ctrl+C
— — —

Collect Service Data F2

Figure 4-36 Selecting Collect Service Data from the Options menu
2. In the confirmation dialog box, click Yes.

A zip file is saved in this folder:
\STRATASYS_J700_DENTAL\ServiceData.

3. Copy this file to a location that is not on the printer computer (for
example, a network folder or a USB drive).
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Improving
Print Quality

Cleaning the
Print Heads,
Roller and
Wiper
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If you suspect that print quality is poor, perform the pattern test (see "Pattern
Test" on page 4-29). If the results are poor, use the following procedure to
improve print quality.

If the results of the last pattern test are poor:

1. From the Options menu, select Purge Sequence, or press F4.

2. In the confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the wiper
removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see "Cleaning the Print Heads, Roller and
Wiper" below).

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left
on them.

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

> Optimize the print heads and replace faulty print heads, if necessary (see
"Optimizing (Calibrating) Print Heads" on page 4-47).

Regular inspection and cleaning of the orifice plates on the bottom of the
print heads prevents print nozzles from clogging. Cleaning the roller and
wiper are also important for maintaining quality printing. A wizard adjusts
printer components to enable access to these key areas, and it guides you
through the cleaning procedure. To maintain the printer in optimum
condition, run the wizard after every print job, when you remove the model
from the build tray. This procedure takes about 20 minutes.

To clean the print heads, roller and wiper:

1. Prepare—
O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O disposable cleaning gloves
O a supplied cleaning cloth or equivalent

O a mirror
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2. Start the Cleaning wizard from the Options menu.

File Options Help

Go to Tray Upper Position F5
Go to Purge Position F6
Wipe F7
Go To Head Inspection F&

Go to Tray Lower Position

Execute Purge Sequence

Pattern Test
Dynamic Mozzle test

Wizards
Built In Tests...

Material Replacement

Head Filling Calibration

Maintenance Counters.., c'““'ﬂgk
Collect Service Data UV Calibratian
UV Lamp Replacement

Head Alignment

| Previous job last slice: 0 Head Optimization

. Load Cell Calibration
FullCure70 Shutdown

Figure 4-37 Options > Wizards menu

Cleaning Wizard
L Check Printer
Q ‘ Canfirm before continuing:
¥
b2
[ Tray is empty
—_— [7] Cover is closed.

stratasys
x LCancel -=:ZZ:E Previous | | Mext E'ZZ:-

Figure 4-38 Preparation check

The printer moves components to the cleaning position.

. When the following screen appears, open the printer.

Cleaming Wizard

L Check Printer
[Q ‘ Canfirm before continuing:
= [] The print heads are clean.

—_— [ The roller was manually rotated and cleaned,

[] The wipes blade is claan

stratasys
X Cancel <% Previous | | Newt > |

Figure 4-39 Wizard screen during cleaning tasks
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Warning: Hot Surface

The print head orifice plates (bottom surface) may be hot. Do not touch them
with your bare hands, and proceed with caution.

4. Place the mirror on the build tray.
5. Put on the gloves.

Caution

Uncured printing material on the print heads might cause skin irritation. Use
disposable cleaning gloves to protect your hands.

6. Soak the cleaning cloth with alcohol.

7. Clean the orifice plates, with a back-and-forth motion. Use the mirror to
make sure that you have removed all of the residue material.

Figure 4-40 Cleaning the heads

Once a month, remove and clean the print-head splash shield. (See step 4
on page 4-46.)

8. After cleaning the print heads, clean the entire roller surface, by rotating it
as you clean.

9. Clean the glass lens on the UV lamps.

10. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.
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11. Remove any pieces of waste material collected in the purge unit. If
necessary, remove the waste collector to clean it. Wipe the rubber seal.

Figure 4-41 Purge unit waste collector

Note: When returning the waste collector to the purge unit, make sure to insert it
as shown.

12. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

13. When you have finished cleaning, select the confirmation check boxes in
the wizard screen (see Figure 4-39) and click Next.

14. Remove the cleaning materials from the printer and close the printer
cover.

15. Select the confirmation check boxes in the wizard screen and click Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Cleaming Wizard

Wizard Completed

Ly

&

stratasys

7% Cancel | <% Previous | « Done

Figure 4-42 Cleaning wizard—final screen

16. Click Done to close the wizard.
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Cleaningthe  The roller waste collector removes waste material scraped from the roller.
Roller Waste Suction removes this waste to the printer’s waste container.

Collector and
Inspecting the
Roller Scraper

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow into
the printer.

To clean the roller waste collector:

1. Prepare—

M2.5 and M2 Hex (Allen) keys
disposable cleaning gloves

isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
cleaning cloth

QaaooaQ

cotton swabs (Q-tips or similar)
2. Put on the gloves.
3. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Fan power
connector

UV Power
connector

Screw

Figure 4-43 Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and
lift up the UV lamp.
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4. Loosen the two screws securing the suction tube on the print block.

Suctiontube
SCrens

Figure 4-44 Lifting the suction tube
5. Lift the suction tube to secure it in a raised position.

6. Remove the two screws securing the covering of the roller waste collector
and remove it.

Be very careful to save the covering screws. These are special screws; if they
are lost, you need to order replacements.

Rollerwaste
- collectorscrews

Figure 4-45 Removing the roller waste collector covering
7. Remove the covering by pulling it out, and then lower it.
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8. Clean the roller waste collector and the scraper blade surface using cotton
swabs. Make sure to remove any remaining printing materials.

Figure 4-46 Cleaning the roller waste collector

%{ Before replacing the covering, you can check the effectiveness of the roller
scraper—see below.

To check the effectiveness of the roller scraper:

1. Put on the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.
4

. Turn the roller slowly with your hand. As the blade scrapes the roller,
make sure the isopropanol is spread evenly over the entire length of the
blade.

5. Inspect the roller. If it is not dry, replace the blade. (See "Replacing the
Roller Scraper" on the next page.)

6. Before returning the roller waste collector to the print block, make sure
that the pins are clean.

Rollerwaste
collector pins

Figure 4-47 Roller waste collector pins

To re-assemble the components:

1. Return the roller waste collector to the print block and screw on the
covering (see Figure 4-45 on the previous page).
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2. Loosen the screws securing the suction tube.
r
== Securing
> SCMaNs

Figure 4-48 Suction tube correctly positioned

3. Lower the suction tube so that the hole in the panel behind the tube is
visible, and tighten the screws to secure the tube.

4. Attach the right-UV-lamp assembly to the print block and reconnect the
UV power and fan cables.
Replacing the  You should replace the roller scraper blade—
Roller Scraper « after 1,000 hours of printing.
« if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See "Cleaning the Roller Waste Collector and
Inspecting the Roller Scraper" on page 4-36.

To replace the roller scraper:
1. Prepare—
3 anew roller scraper blade
3 a Phillips 1x75 mm screwdriver
O a2.5-mm and a 2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 4-36).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 4-49 Removing the roller waste collector

DOC-08040 Rev.D 4-39



Stratasys J750 User Guide 4 Operating and Maintaining the Stratasys J750 3D Printer

4. Remove the screws that secure the roller scraper assembly.

Figure 4-50 Removing the roller scraper screws
5. Remove the scraper blade and discard it.

a
e ™

Figure 4-51 Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown.

Toval nole
in hgﬁey
(round hola
in Blade)
[=]

Figure 4-52 Inserting the new roller scraper blade
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7. Insert and tighten the roller scraper blade screws.

Important:

« Tighten the screws in the order shown in Figure 4-53.
« Use the new screws supplied in the replacement kit

)

Figure 4-53 Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the
print block. (See steps 4 to 6 on page 4-36 in "Cleaning the Roller Waste
Collector and Inspecting the Roller Scraper".)

You should check the alignment of the print heads—

« once a month
« after replacing one or more heads

« if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see "Cleaning the Print Heads, Roller and
Wiper" on page 4-32).

This procedure takes about 20 minutes.
To check the alignment of the print heads:
1. Prepare—
O a transparency sheet, A-4 or Letter size

O any type of adhesive tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment wizard from the Options menu.
3. Click Next to begin, and close the cover.

4. In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.
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5. When instructed to do so, place the transparency on the build tray— next
to the left and rear edges of the tray, as shown in the following figure.

Figure 4-54 Positioning the transparency on the build tray
6. Make sure that the transparency sheet is lying flat, and tape it to the tray.

7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.
8. When the following screen appears, remove the transparency.

Head Alignment Wizard ‘

L Check Printer
J'__ Confirm befare continuing:
¥
Z [ The transparency iz secured to the build tray. |
stratasys

Figure 4-55 Head Alignment wizard—steps 8—10

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

Print Head Numbers
HO H1 H2 H3 H4 H5 HG

1304 BE7 (ST T BN BET [T BT T 1304 BET 1304 W7 ST R

I Illl:l I|||||i||||I |||“|||| T I |"HI|I|I| TN

LT R T T T de M

|III|III|II |||'|II IIIll I||||”|||I IIIII HlllI IIIIII IIIII |”I|| |I|II| S

IIII I I I| III |||I||= IIIII I|||| | I|||I IIIII ”IllI IIIIII I IIIII III III II IIII I|IIIII IIIII

i | W |'|'|'! 1, W | W I|I|||I R H iy I|||||I m

Figure 4-56 Sample head-alignment test

Note: There is no column for head H7 because its alignment is used as a
reference for aligning all other heads.
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0.

10.

11.

12.

For each column of lines, use a magnifying glass or loupe to inspect pairs
of consecutive rows printed on the transparency to see where the vertical
lines align.

1234567
i SR -’/:'/-"

wu [

Figure 4-57 Comparing rows of alignment lines

Note: Itdoes not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper and
lower rows are aligned, Figure 4-57. In the example shown, no change to
the head alignment is necessary. If other lines in the set are aligned, you
need to change the alignment of that head—in the next wizard screens.

In the wizard screen shown in Figure 4-55, select the Transparency
removed check box, and click Next.

The first in a series of alignment screens appears.

Head Alignment Wizard
1234567 Head 6
SN L
1T Selectthe number representing the aligned lines
P |} onthe transparency.
{ [T
[RIRRIN
nmn 1 2 3 4 5 B 7
[RIRRIN °
[T
(NARNAN
2 Help | XK Cancel | |~(Erevious| | Mext = |

Figure 4-58 Head alignment selection

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

Click Next to display the next head alignment screen, and again select the
number representing the most closely aligned vertical lines on the
transparency for that print head.
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When you have finished aligning all of the heads, the following screen is

displayed.

Head Alignment Wizard

Select Action

@ Update spstem with new parameters.

_ Keep previous parameters.

stratasys

I XK Cancel ‘ I%Erevious‘ [ Mext = ]

Figure 4-59 Parameter update confirmation

13. Continue as follows:

O To make the alignment changes in the printer, make sure that Update

system with new parameters is selected, and click Next.

O To recheck the alignment test results before making the alignment

changes in the printer, click Previous.

O If you do not want to make alignment changes in the printer at this

time, select Keep previous parameters, and click Next.
14. In the following screen, you can choose to either repeat the head

alignment procedure or close the wizard.

O If the most closely aligned vertical lines for a print head were at either

extreme, choose Repeat the test, then click Next.

The transparency test will show if the heads are now properly aligned,
and—if not—the wizard will allow you to “fine tune” the alignment.

O If the vertical lines for the print heads were not aligned at either
extreme, choose End the wizard, then click Next.

Head Alignment Wizard

Select Action

@ Fepeat the test and print another transparency.

1 End thiz wizard.

stratasys
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Figure 4-60 Repeat head alignment option
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Cleaningthe  To prevent excess printing material from accumulating around the print

Print-Head heads, a splash shield is installed on the bottom of the print block. Remove

Splash Shield the shield and clean it once a month, when cleaning the print heads (see
"Cleaning the Print Heads, Roller and Wiper" on page 4-32).

To remove the print-head splash shield:

1. Run the Cleaning wizard from the Options menu.

When the printer moves components to the cleaning position, the
following screen appears.

Cleaning Wizard

L Check Printer

S "ﬁ Confirm before continuing:

[ The print heads are clean.
[T The roller was manually rotated and cleaned,

[77] The wiper blade is clean

stratasys

[ x LCancel ¢ Previous Mext 5

Figure 4-61 W.izard screen during cleaning tasks

2. Open the printer and place a mirror on the build tray.
3. Put on cleaning gloves.

Caution

Uncured printing material on the print heads might cause skin irritation. Use
disposable cleaning gloves to protect your hands.
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4. Using a 2-mm hex (Allen) key, remove the screws to remove the splash
shield.

Figure 4-63 Removing the print-head splash shield

Warning: Hot Surface

g The print head orifice plates (bottom surface) may be hot. Do not touch them
with your bare hands, and proceed with caution.

5. Soak a cleaning cloth with alcohol and clean the splash shield.

6. Return the splash shield to the print block and secure it with four (4)
SCrews.

After cleaning the print heads and the splash shield, continue with step 8 in

the daily cleaning routine (see "Cleaning the Print Heads, Roller and
Wiper" on page 4-34.
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Optimizing

(Calibrating)

Print Heads

The condition of the print heads directly affects the quality of printed models.
To maintain optimum printing, you should routinely test the print heads, and
calibrate them to the best working configuration possible by running the
Head Optimization wizard every 300 hours of printing.

During this procedure, you place a scale on the build tray and connect it to
the printer. Printing material (resin) is jetted from each head and its weight is

automatically recorded and the wizard determines how to optimize the print
heads.

If, during the optimization process, the wizard determines that a print head is
faulty—or that it is negatively affecting layer uniformity with the current head
configuration—the wizard instructs you to replace it. If this happens, you can
continue the wizard to replace the print head, or abort the wizard, to replace
the head at another time.

%{ Run the Head Optimization wizard every 300 hours of printing or whenever

DOC-08040 Rev.D

the condition of print heads is negatively affecting the quality of printed
models, or if you suspect that there is a problem with one or more of the print
heads.

Note: To accurately test and calibrate print heads, they must be clean. If
necessary, run the Cleaning wizard before beginning this procedure.

To test and calibrate the print heads:

1. Prepare—
O disposable cleaning gloves (any clean, powder-free protective gloves)
O pink paper
O the Missing Nozzles ruler

O the scale supplied for use in the Head Optimization wizard

Important: Ensure that the scale is calibrated before beginning this
procedure.

2. Start the Head Optimization wizard from the Options menu.

File Options Help
Go to Tray Upper Position
Go to Purge Position 18 Jun 2017 14:01
Wipe
Ge To Head Inspection

Cabinet B
FullCure705  FullCure705

Go to Tray Lower Position

Execute Purge Sequence

SH-L SH-R
Pattern Test

Dynamic Nozzle test 400 gr

Wizards Material Replacement Shift+Ctrl+R
BuiltIn Tests... Ctrl+Alt+B Head Filling Calibration Shift+Ctrl+F
Cleaning Shift+Ctrl+E
UV Calibration

UV Lamp Replacement Shift+ Ctrl+U

Maintenance Counters... Shift+ Ctrl+C
Collect Service Data F2

Head Alignment

Previous job last slice: 0

Head Optimization
Load Cell Calibration Shift+Ctrl+L
Shutdown Shift+ Ctrl+D

Figure 4-64 Starting the Head Optimization wizard

3. In the opening wizard screen, click Next to begin.
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The Wizard Conditions screen appears.
4. Read the conditions, select | Agree and click Next.

5. In the following screen, select Continue with Head optimization if you have
recently cleaned the print heads. Otherwise, cancel the wizard and run the
Cleaning wizard.

Head Optimization Wizard

p = N Select Action

If ywou are not sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

() Cancel this wizard to clean the heads first.

(@ Continue with Head Optimization.

stratasys

’ XK Cancel ] ’{Erevious] [ Mext = ]

Figure 4-65 Clean print heads screen

6. In the following screen, make sure Optimize all print heads is selected,
and click Next.

Head Optimization Wizard

p = N Select Action

(@ Optimize all print heads.

() Replace faully heads and optimize all heads.

stratasys

Figure 4-66 Procedure selection screen
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7. Select the printing mode for which you want to optimize the print heads

and click Next.
Select Action
(71 High Speed/High Mix
() High Quality
stratasys

Figure 4-67 Printing mode selection

8. When the following screen appears, tape a sheet of pink paper to the
surface left of the build tray, close the cover and click Next.

Head Optimization Wizard

L. Check Printer

Q Confirm before continuing:
> [ The build tray is empty.

— [] The cover is closed.

stratasys

’ x Lancel ] ’{ Erevious]

Figure 4-68 Preparations confirmation

The printer prints a frame on the build tray and then prints the Pattern
Test.

9. When the Pattern Test is printed, carefully inspect it, using the Missing
Nozzles Ruler to see if there are missing lines.

Print Biock &

Frant of Pravier §
Figure 4-69 Inspecting the Pattern Test
Each missing line represents a faulty nozzle in the print head.
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10.In the following wizard screen, enter the number of missing nozzles for
each print head and click Next.

Head Optimization Wizarc
Enter Missing Nozzles

Open the cover and remove the pattem test paper.
Enter the number of mizzing nozzles for each head below.

a a a a a a a a
Head 0 Head 1 Head 2 Head 3 Head 4 Head 5 Head 6 Head 7

stratasys

Figure 4-70 Enter Missing Nozzles screen

11. The wizard continues according to the number of missing nozzles you
entered.

O If there are too many missing nozzles for acceptable printing, the
wizard instructs you to replace the defective print head(s). You can do
this now, or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you
through the procedure when you click Next. Make sure you have
replacement heads and the required tools (see page 4-55). Then,
continue with "Preparing the Print Block" on page 4-56.

Head Optimization Wizard

7= Error: High Missing Nozzle Count

Head 5 defective.

@ Replace defective heads).

() Abart wizard.

stratasys

Figure 4-71 Head replacement due to missing nozzles

O If the number of missing nozzles in all print heads is acceptable, the
wizard continues with the head optimization process (below).
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12. Set up the scale in the printer by performing the steps listed in the wizard
screen.

Head Optimization Wizarc

Prepare Scale

Ferfarm the steps in the order below and confirm:

[ Position scale on tray and connect cable to printer.
[ Press ' to turm on the scale [withaut the container).
[T ait for the scale to display '0.00°

[] Place the cantainer on the scale .

[ Press 'T' ta zero the scale with the container

[ Close the printer cover.

stratasys

Figure 4-72 Setting up the Head Optimization scale
13. After confirming all of the items listed in the wizard screen, click Next.

Printing material (resin) is jetted from each head and its weight is
automatically recorded. This process is repeated for each printing mode,
after which the following screen appears.

Head Optimization \Mza_

Empty the Resin Container

Ferfarm the following:

[] Empty container into purge urit.
[ Return the container to the scale.

[ Close printer cover.

stratasys

Figure 4-73 Emptying the resin container

14. Carefully remove the resin container from the scale and empty it into the
purge unit in the printer. Then return the container to the scale.

& Caution: The resin in the container is uncured

« To prevent contact with skin, wear neoprene or nitrile gloves.
« Dispose of uncured resin in accordance with applicable regulations. By

emptying the container into the purge unit, the resin is stored in the printer's
sealed waste container.

15. Close the printer and click Next.
The printer cures the remaining resin in the container.
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16. When the following screen appears, remove the scale and clean the build
tray.

Head Optimization Wizard

Remove Scale

Confirm before continuing:

[ The scale and cable are removed.

[ The build tray is empty and clean.
[ The cover iz closed.

stratasys

Figure 4-74 Remove the scale confirmation screen

The wizard uses the data collected to analyze the condition of the print

heads and optimize them so they print models with a uniform layer of

material.

O If the heads are in satisfactory condition, the following wizard screen
appears.

Head Optimization \Mza_

Wizard Completed

L
M Click ‘Done’ ta restart the printer application.

stratasys

Figure 4-75 Final wizard screen, after optimizing print heads
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a

If the wizard determines that a print head is faulty—or that it is
negatively affecting model quality with the current head
configuration—you need to replace it. Indicate whether or not you
want to do so now.

Head Optimization Wizard
Weight Test Results
Head b defective.
@ Replace defective head(z].
Abart wizard.
stratasys
2 Help XK Cancel

Figure 4-76 Defective print heads found

« Select Replace defective head(s) if you are prepared to replace the
print heads now (see below).
or—

« Select Abort wizard if you want to replace the print heads at
another time.

Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.

To replace print heads, you need these tools and materials:

a
a
a

aaaa

m

replacement print head(s)
isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

a supplied cleaning cloth or equivalent
a mirror
a 3-mm hex (Allen) key (depending on the type of print block)

the scale supplied for use in the Head Optimization wizard (Weight
Test)

the Missing Nozzles ruler

If you are replacing print heads now, the wizard guides you through the
procedure when you click Next. Continue with "Replacing Print Heads" on
the next page.

DOC-08040 Rev.D

4-53



Stratasys J750 User Guide 4 Operating and Maintaining the Stratasys J750 3D Printer

Replacing
Print Heads

DOC-08040 Rev.D

The condition of the print heads directly affects the quality of printed models.
You may need to replace a print head if one or more of the following
symptoms occurs:

» The Head Optimization wizard determines that a print head is defective.
(See "Optimizing (Calibrating) Print Heads" on page 4-47.)
« There are noticeable grooves in the surface of printed models.

« Visual inspection of the head reveals that its surface is damaged—peeling
or bubbles in the nozzle area.

« The printer interface displays a warning or malfunction message relating
to a print head—

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.

The Head Optimization wizard guides you through the procedure of replacing
a print head, and configures printer components to enable you to perform it.
Only replace a print head with the aid of the wizard.

The entire print-head replacement procedure takes about 45 minutes, and
consists of the following phases:

A. Identifying the head(s) needing replacement.

=

mHE oo

This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction message
indicates which head needs replacing.

Preparing the print block for head replacement.
This is done automatically when you run the wizard.
Removing the defective print head.

Installing a new print head.

Optimizing the print heads (done automatically by the wizard).

Performing head alignment.
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To replace a print head:
1. Prepare—
O replacement print head(s)
O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

O disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

a supplied cleaning cloth or equivalent
a mirror
a 3-mm hex (Allen) key, depending on the type of print block

aaaaqn

the scale supplied for use in the Head Optimization wizard (Weight
Test)

O the Missing Nozzles ruler
Important: Make sure that you have these items and that the scale is

calibrated and fully charged before continuing. It is highly recommended to
connect the scale to the wall power socket when running this wizard.

2. Start the Head Optimization wizard from the Options menu (see the figure
on page 4-47).

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select | Agree and click Next.

5. In the following screen, select Continue with Head optimization if you have
recently cleaned the print heads. Otherwise, cancel the wizard and run the
Head Cleaning wizard.

Head Optimization Wizard

Select Action

If ywou are not sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

Cancel this wizard to clean the heads first.

@ Continue with Head Optimization.

stratasys

| XK Cancel | |~(Erevious| [ Mext = ]

Figure 4-77 Clean print heads screen
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Print Block
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6. In the following screen, select Replace faulty heads, and click Next.

Head Optimization Wizard

Select Action

() Optimize all print heads.

(@ Replace faulty heads and optimize all heads.

stratasys
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Figure 4-78 Procedure selection screen

Head Optimization Wizard

L Select heads to be replaced

Head 01 Head 2-3 Head 4.5 Head £-7
[l [l [l [l

stratasys
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Figure 4-79 Head selection screen
The printer heats and empties the print block, and prepares the printer.
(This should take up to 15 minutes.)
The following screen appears when the printer is ready for you to replace
print heads.

Head Optimization Wiza

Print Head Replacement

The printer is ready foryou to replace print heads.

&
f Click 'Next' to continue.

stratasys

E

Figure 4-80 Printer ready for head replacement

. Put on the protective gloves and open the printer cover.

Note: The printer disconnects power to the heads for your safety.
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Removingthe 9. On the front of the print block, loosen the screws that secure the cover
Defective Head protecting the print-head driver cards.

POCOOCOCTOD
ROt OoO®Be@TCOoQ

9 e0®6Oe 0| =
CeowTeBeCa
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Figure 4-81 Loosening the driver-card cover screws
10. Lift up the cover.
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11. Loosen the screws that secure the driver-card bracket, and lower the
bracket.

Figure 4-82 Loosening the driver-card bracket screws
12. Release the driver-card support.

Figure 4-83 Releasing the driver-card support
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13. Remove the driver card by releasing the latch at the points shown.

Figure 4-84 Releasing the driver-card latch

14. Release the upper and lower screws that secure the print head in the
block. (If necessary, you may use a 4-mm hex (Allen) key to loosen the
SCrews.)

Figure 4-85 Releasing the print-head locking screws
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15. Press down on the upper and lower locking screws to release the print
head, and remove it from the bottom of the print block.

Figure 4-86 Releasing the print head

16. Make sure that along with the head, you remove the four (4) rubber O-
ring seals.

Figure 4-87 O-ring seals on the print head
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%{ Important

If the seals are not removed with the head, they are probably stuck to the print
block housing. If so, remove them.

Figure 4-88 Making sure the O-rings are not stuck to the print block

Installing the 17. Place four (4) O-ring seals in the replacement head (see Figure 4-87 on the
New Head previous page).

18. Position the head in the print block, making sure that the location pins
are in place.
Note: Make sure to insert the head with the contacts on the driver card facing
the print block.

19. Tighten the upper and lower screws that secure the print head in the print
block (see Figure 4-86 on the previous page).
Note: Hand-tighten these screws. To avoid over-tightening, do not use a hex
(Allen) key.

20.Insert the driver card into its socket, and secure the card.

N 3%\1_@*.

Figure 4-89 Securing the driver card

21. Lower the protective cover and tighten the screws to secure it.
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22.1n the Replace print heads screen, select the check box to confirm that
you have replaced the head(s), and click Next.

Head Optimization Wiza

Replace print heads

Fefer to the instructions included in the head
replacement kit, ar click 'Help'. Canfirm:

Head 0 replaced
HO-1 H2-2 H4-5 He-T

stratasys
’ 4 Help ] ’ Wiew Movie ] <EErevious
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Figure 4-90 Head replacement confirmation

23.With your fingers, make sure that the new head is level and even with the

other heads.
T T
i a,._a,%_-f, LU
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Figure 4-91 Checking the level of the new head

24.Confirm that the heads are level by selecting the check box in the
following wizard screen, and click Next.

Head Optimization Wiza

Installation Check

Check thatthe print heads are level and ewven.

[T Done

stratasys
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E

Figure 4-92 Installation-check screen
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25.In the next wizard screen, confirm that you have removed all tools and
objects from the printer.

Head Optimization Wizan

Check Printer

Confirm before continuing:

[ The build tray is empty.
[ The cover iz closed.

stratasys
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Figure 4-93 Cleared-tray confirmation screen
26.Close the printer cover.

The wizard continues by heating the heads, then filling and purging them.
If there are no installation problems, the optimization procedure begins,
to calibrate the print heads to the best working configuration—see
"Optimizing (Calibrating) Print Heads" on page 4-47.

If installation problems are detected, the wizard alerts you and instructs
you how to continue (see "Installation Problems" on the next page).

27. After replacing print heads, you should check the head alignment before
using the printer to produce models. In the final wizard screen, select
Optimize all print heads and click Next to run the Head Alignment wizard.

Head Optimization Wizan

Select Action

(@ Optimize all print heads.

() Replace faully heads and optimize all heads.

stratasys

Figure 4-94 Final wizard Screen
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Installation If the printer detects that there is a problem after you install print heads,
Problems relevant warning screens appear.

« If the printer software does not detect the replaced head, the following
warning screen appears.

Head Replacement Wizard

‘4

One or more heads
not inserted correctly

Remmaove and re-insett the driver connector(s)

1

stratasys
? Help x Lancel | ‘% F |

Figure 4-95 Incorrect-installation screen
If this happens:

a. Release the print head card and re-insert it. (see "Removing the
Defective Head" on page 4-57).

b. In the wizard screen, select the check box to confirm that you have
re-inserted the card, and click Next.

« If the replacement head was not factory-calibrated, the following warning
screen appears.

Head Replacement Wizard B|
Inserted head does not contain
S factory data
The installed head does not contain valid data. Try
replacing it with another head. Ifthis does not
i succeed, contact Customer Support.

[~ Aternate print head installed.

stratasys
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Figure 4-96 Invalid-data warning screen
If this happens:

a. Remove the head and replace it with another one (see "Removing the
Defective Head" on page 4-57).

b. In the wizard screen, select the check box to confirm that you have
installed another print head, and click Next.

c. Contact your authorized Customer Support center about the
unformatted head.
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« If the vacuum test is not successful, the replacement head was not sealed
properly during installation, and the following warning screen appears.

Head Replacement Wizard @

Vacuum leakage detected!

Avacuum leakage was detected. The next steps will guide
yau through the procedure for re-installing the head(s).

stratasys
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Figure 4-97 Vacuum-leakage warning screen
If this happens:

a. Click Next.

b. Follow the instructions on the wizard screens to re-install the head.

Testing and The level of UV radiation from the lamps used for curing models can change

Calibrating the over time. To ensure optimum curing of models during printing, a pop-up

UV Lamps message reminds you to test the lamps and calibrate the level of UV radiation
after every 300 hours of printing. You do this by running the UV Calibration
Wizard.

To measure the UV radiation, you need:

« Stratasys TOL-03005-S (UV sensor and cable)
or—

« a stand-alone UV radiation meter, approved for use with the printer

The wizard compares the measured radiation to the recommended radiation
level for each of the lamps, at each printing mode—High Speed, and High
Quality and Digital Material.

When calibrating the lamps, the wizard attempts to adjust the radiation level,
if necessary.

« If the reading is within the acceptable range, the wizard continues to the
next phase.
« If further adjustment is necessary, the current phase is repeated.

« If the level of UV radiation is too low to be properly adjusted, the wizard
continues to the next phase, but the final wizard screen indicates that the
lamp’s radiation for the printing mode is unacceptable.

%{ Before testing and calibrating the UV lamps:

« Make sure the glass lens on each of the UV lamps is clean. For easy access,
run the Head Cleaning Wizard, and use the special cleaning pad supplied.

« Make sure that the glass over the UV radiation sensor is clean.
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To test and calibrate UV lamp radiation:
1. Start the UV Calibration Wizard from the Options menu.

2. In the following screen, select Calibrate UV Intensity to adjust the lamp’s
radiation level to the acceptable range.

UV Testing/Calibration Wizard

Select Action

) Test UV intengity

@ Calibrate LI intensity

_ Calibrate U sensor box [Support use only]

stratasys

Figure 4-98 UV Test/Calibration selection

3. In the following screen, select the UV sensor and measuring device to be
used.

-
UV Testing/Calibration Wizard

Select Device

@ LY zenzor box

1 IV external radiation meter

stratasys

Figure 4-99 UV device selection

%{ UV Measuring Device

When you use the Stratasys UV sensor box (TOL-03005-S), you connect it to
the printer. The wizard automatically measures and calibrates the UV
radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the
readings from the meter in the wizard screens.
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4. Make sure that the build tray is empty. Confirm this in the wizard screen

DOC-08040 Rev.D

and click Next.

UV Testing/Calibration Wizard

Check Printer

Confirm befare continuing:

stratasys

The build tray is emphy.

x Lancel

Figure 4-100 Printer preparation

> When using a Stratasys UV sensor box that you connect to the printer

(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the

next page.

> When using a stand-alone UV radiation meter, continue with "External

UV Meter" on page 4-69.
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UV Sensor The following steps apply when using the Stratasys UV sensor box that you
Connectedto connect to the printer. They do not apply when using a UV external radiation
Printer measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from
the label on the back of the UV sensor box.

f UV Testing/Calibration Wizard
Synchronize the wizard and the
UV sensor
Enter the CF number printed on the LY-gensor label.
stratasys

Figure 4-101 UV sensor synchronization

q‘f Stratasys”

PN L W

UV SENSOR
em:  AAFUE ooy

IF= [

CIF:
Callbration date: _t.‘IhJ_‘Llf_

e

Figure 4-102 Label on the bottom of the UV sensor box
2. Click Next.
The build tray lowers so you can connect the UV sensor box.

Figure 4-103 UV sensor connector
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3. Connect the UV sensor cable to the connector in the printer.

To ensure that the sensor cable does not interfere with the build tray when it is
raised, route it in back of the sensor.

4. Confirm the items listed in the wizard screen and click Next.

UV Testing/Calibration Wizard

Place Sensor

Confirm befare continuing:

The UV zenzor box iz connected to the printer.
The UV senzor box iz positioned an tray az shown,
The glazz in the UV sensor box is clean.

The zensor cable iz secured ta the tray.

The printer cover iz closed.

stratasys

X LCancel

Figure 4-104 Sensor positioning
Continue with "UV Measurement " on page 4-71.
External UV The following steps apply when using a stand-alone UV meter. They do not
Meter apply when using the Stratasys UV sensor box connected to the printer.

1. When the following screen appears, open the printer and place the UV
sensor (probe) at the rear edge of the tray, in the center.

UV Testing/Calibration Wizard

M . Place Sensor
— S

Confirm befare continuing:

The UV zenzor iz in the center of the tray's far edge.

The zensor cable iz routed to the front of the printer.

stratasys
2 Help XK Cancel

Figure 4-105 Sensor placement screen
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2. Lead the cable out of the printer so that you can close the printer, and

tape it down to make sure that it does not interfere with the moving print
block.

I
Figure 4-106 Correct UV-sensor placement

3. Close the printer, while checking that the sensor does not move out of
position.

Set the UV meter to measure mJ/cm2.

Set the range on the meter to 2,000.

Connect the cable from the sensor to the UV meter.

Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

© N oo p

In the wizard screen, confirm that the sensor is positioned correctly, and
click Next.

Continue with "UV Measurement " on the next page.
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UV The UV lamps power up and stabilize. (This takes several minutes.) Then, the
Measurement print block passes over the sensor and the wizard compares the measured
radiation to the recommended level for each UV lamp and printing mode.
During this process, which takes 20—40 minutes, you need to monitor the
progress as displayed in the wizard screen.

UV Testing,/Calibration Wizard

UV Intensity Measurement

—.
' _:% Currently reading  Right UV lamp in High Mix Mode

Lamp Initialization
| (~120 sec.)

UV measurement

Overal progress

stratasys

Figure 4-107 UV measurement progress

When using a stand-alone radiation meter, reset the meter and enter the
reading (measurement) when you are prompted to do so.

Enter, Yalue E|

Enter U measurement device reading

Figure 4-108 UV Measurement dialog box

If the UV level measured is not acceptable, the wizard calibrates the UV lamp
by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the
condition of the lamps after calibration (see Figure 4-109 below).

UV Testing,/Calibration Wizard

UV Calibration Results
Left UV Lamp Right UV Lamp
HM S 207.9 % [100%] S 200.2 % [100%]
*® 1495 -» 1455 ® 1655 -» 1495
*Replace lamp *Replace lamp
HQ | of 1404 %[380%] of 1404 % [80%]

1435 -> 1435 1734 > 1435

HS 1T Z110%] & 154.0 % [130%]
Q/‘ 1435 -> 1435 Q/‘ 1734 > 1435

stratasys

Figure 4-109 Results and condition of UV lamps after calibration
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Calibrating the
Load Cells
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After examining the UV calibration results:
1. Click Next.

2. Remove the UV sensor and close the printer cover. After confirming the
items listed in the wizard screen, click Next.

If the results are not acceptable for quality printing, this is indicated in the
final wizard screen.

3. In the final wizard screen, click Done.

UV Testing/Calibration Wizard

Wizard Completed

L

&

Replace the LNV lampis).
Contact customer suppaort.

stratasys

Figure 4-110 Final UV Calibration Wizard screen

Load cells are sensors that measure the weight of the material cartridges and
the waste container in the printer. It is important that you periodically check
that the weight measurements are accurate to prevent unnecessary waste of
printing materials. It is recommended that you calibrate the load cells once a
month.

To calibrate load cells:
1. Start the Load Cell Calibration wizard from the Options menu.

2. In the following screen, select one or more load cells that you want to
calibrate.

Load Cell Calibration Wizard

Select Load Cells to Calibrate
Remove each cartridge you selected from the cabinet.
Cabinet A Cabinet B
— AN AN
"B, N, | - ir-n
Waste TACN NN
AN AN
stratasys - - - -
x Lancel

Figure 4-111 Load cell selection
3. Remove each selected cartridge from the materials cart, and click Next.

4. In the next wizard screen, observe the numbers and wait until the weight
level is relatively stable—two units above or below the average level shown.
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Flushing the
Print-block
Heater

Load Cell Calibration Wizard

~

L

Indicate when Values are Stable

“wait 10 full seconds for the load cell value to stabilize.

Cabinet A

Cabinet B

[1163480 [1164060

EEN

Waste  [1162320 [1162900

[1168360 [1167540

[ o [1161160 [1161740

[1165800 [1166380

[1160000 [1160580

[1164640 [1165220

Stratasys ["]¥alues are stable

S

Figure 4-112 Weight stabilization
5. Select the check box, and click Next.
6. Click Done in the final wizard screen.

If the printer was once configured to print with six Model materials and later

configured to print with three Model materials (High Speed mode), the

unused channels in the print-block heater need to be periodically flushed to

prevent clogging. A reminder message appears if 250 printing hours have

passed since changing to 3-material printing or since the print-block heater
was last flushed.

QE{ This procedure takes about 90 minutes to complete.

DOC-08040 Rev.D

To flush the Print-block Heater:

1.

From the Options menu, open the Material Replacement wizard.

File Cptions Help

Go to Tray Upper Position

Go to Purge Position

Wipe
Go To Head

Inspection

Go to Tray Lower Position

Execute Purge Sequence

Pattern Test
Dynamic Nozzle test

Wizards

Built In Tests...

Maintenance Counters...

Collect Service Data

Previous job last slice: 0

24 Oct 2017

Cabinet B

Material Replacement
Head Filling Calibration
Cleaning

UV Calibration

UV Lamp Replacement
Head Alignment

Head Optimization
Load Cell Calibration
Shutdown

Figure 4-113 Opening the Material Replacement wizard

2. In the opening screen, click Next.
3. In the Material Replacement Options screen, click Advanced Settings.
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Suppart

Material Replacement Wizard

Material Replacement Options

Printing mode
@ B materials (High Mix ! High Guality)

() 3 materials (High Speed)

Required materials
Mote: Cartidge positioning in material cabinet is determined automatically.

Both cartridges ) Full @ Economy
Both cartridges: ) Full @ Economy
Both cartridges ) Full @ Economy
Both cartridges O Full @ Economy
Both cartridges () Full @ Economy
Both cartridges ) Full @ Economy
@2 0304 caridges

'Full’ provides you with exact color immediately.
'Economy’ enables a faster material replacement cycle.

2 Help | &dvanced Settings... |

Figure 4-114 Material Replacement Options screen
4. In the Advanced Settings screen, select Manual slot selection and click

Apply.

Material Replacement Wizard

/-

=\ Advanced Settings

Cartridge positioning:
(2 Automatic slot selection (Recommended)
@ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

[7] Enable "flush again” options

Stralasvs This selection applies to this use of the wizard only.
) |

Figure

4-115 Manual slot selection
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5. When the Material Replacement Options screen opens again, select the

following;:

3 6 materials

O Both cartridges
O Economy

Material Replacement Wizard

Printing mode
(0 6 materials (High Mix/ High Quamﬂ)

3 materials (High Speed)

Required materials
Mote: Cartidge positioning in material cabinet is determined automatically.

FullCure720 = V| Both cartridges
VeroBlack W V| Both cartridges
VeroBlue ) V| Both cartridges
VeroClear ) V| Both cartridges
VeroCyan n | Both cartridges

[veraveliow | | FBoth canidges

Support | FullCure705 hd 203@4 carridges

‘Full’ provides you with exact color immediately.
'Economy’ enables a faster material replacement cycle.

[ 2 Help | [Advanced Seings .|

Material Replacement Options

Full |@ Economy
Full |@ Economy
Full |'@ Economy
Full |'@ Economy

Full |'@ Economy

Full |'@® Economy

X Cancel

Figure 4-116 Selections in the Material Replacement Options screen

Make sure that the printer is loaded with the selected materials. This
procedure requires six Model materials to flush all of the channels in the print-

block heater.

6. Click Next.

7. In the Cartridge positioning screen, make sure that the material

cartridges are properly positioned, and click Start.

8. Read the warning message, and click OK.
The wizard drains the Model materials from the print block and fills it

with the selected materials.

This process takes up to one hour. Then, the Wizard Completed screen

appears.
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TETE S . . e
N Wizard Completed
; Printer's current configuration
(% ® Left Right Left Right
— M3 VeroMgnt VeroMgnt support  FullCure705 FullCure705

M2 VeroWhite VeroWhite ME RGD535 RGD535

M1 VeroYellow VeroYellow M5 VeroCyan VeroCyan
Support  FullCure705 FullCure705 M4 RGD515 RGD515

Printing mode: High Mix / High Quality
stratasys
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10.

11.

12.

13.
14.

15.

Figure 4-117 Wizard Completed screen
Click Done.
The printer-control application restarts.

Purge the materials from the print heads 15 times—
Press F4.

or

From the Options menu, select Execute Purge Sequence.

To return to the 3-material printing mode, run the Material Replacement
wizard again.

In the Material Replacement Options screen, select the following:
O 3 materials

O Both cartridges

O Economy

Click Next.

In the Cartridge positioning screen, make sure that the material
cartridges are properly positioned, and click Start.

The wizard fills both channels of each print head with the selected
material

This process takes about 15 minutes.
When the Wizard Completed screen appears, click Done.
After the printer-control application restarts, you can print.
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The tubes that pump waste material from the roller waste collector and the
purge unit should be replaced after 1500 hours of printing. At this time, a
counter should display a maintenance message on the printer interface
screen.

Slice 2020 of 2020 (100.0%)

Previous job last slice: 2019

Maintenance Required

Figure 4-118 Maintenance message

You can verify that the pump tubes need to be replaced by examining the
waste pump maintenance counters.

To open the Maintenance Counters screen:
> Click on the "Maintenance Required" indicator.
or—

> From the Options menu, select Maintenance Counters.

Go to Tray Upper Position F5
Go to Purge Position F&
Wipe F7
Go To Head Inspection F8
Go to Tray Lower Position F10
Execute Purge Sequence F4
Pattern Test F3

Dynamic Nozzle test

Wizards »
Built In Tests... Ctrl+Alt+B

Maintenance Counters.., I}
Collect Service Data F2

Figure 4-119 Selecting Maintenance Counters from the Options menu.

When the Maintenance Counters screen opens, scroll down to the General
Pumps section.

General Pumps

Purge Unit Pump— [2241 [30/e/15 | [3500 Reset I
Fioller ditt Pump 232 [30/0615 | [3500 Reset I
Purge Unit Purtp Tube[7357 [30/06,15 | Jr500 Reset v
Wacuurn Purp 7034 [20/06/15 | 12000 Reset r
Raller Dit Pump Tube [57 [21/0216 | Jt500 Reset v

Figure 4-120 Pump Maintenance Counters

The waste-pump tubes that require replacing are displayed in red.

Note: Ifthe check box on the rightis selected, the "Maintenance Required"”
indicator appears when that task is due.
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To replace pump tubes, you replace the "cassette" assembly that attaches to
the pump in the printer. Replacement cassettes are supplied in the printer
Start-up Kit. Additional cassettes can be ordered from your Stratasys service
provider.

To replace the waste pump tubes:
1. Make sure that the printer is in Idle mode (see the figure on page 4-3).
Note: The printer enters Idle mode about 16 minutes after printing stops. To

force the printer into Idle mode, close the printer application: From the File
menu, click Exit.

2. Using an 8-mm hex (Allen) key, open the two latches that secure the left
printer panel (as you face the printer).

Figure 4-121 Opening a panel latch
3. Open the panel and disconnect the ground (earth) wire.

Figure 4-122 Ground wire connected to panel
4. Remove the panel.
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5. Identify the waste pump that requires tube replacement.

= 1\ & pyrge-unit waste pump

Roller-waste pump

Figure 4-123 Waste pumps

6. Unscrew the fittings that connect the waste tubes to the pump.

7. Remove the part of the fitting remaining on the pump tube, and save it.
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8. When the tubes on both sides of the pump are disconnected, rotate the
pump "cassette" assembly counter-clockwise and remove it.

Figure 4-125 Rotating the pump cassette
9. Install a new pump cassette.
The new cassette contains a new pumping tube.
10. Connect the waste tubes to the new pump cassette.
11. If necessary, replace the pump cassette on the other waste pump.

12. Open the Maintenance Counters screen, scroll down to the General
Pumps section, and click Reset for the relevant counter(s) (see the figure
on page 4-28).

13. Connect the ground wire to the printer panel and attach the panel to the
printer.
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Replacing the  Filters are installed in the line that supplies Vero PureWhite Model material

Vero ) to the print heads. To ensure that the heads remain in optimum condition,

PureWhite the filters should be replaced periodically. A counter keeps track of the

Material Filters  amount of material passing through the filtered line, and the Maintenance
Required indicator appears in the printer interface when it is time for filter
replacement. The counter is set for 15 hours—enough, on average, for about a
year of printing. To check the counter, open the Maintenance Counters
screen (see "Maintenance Counters" on page 4-26) and scroll down to the
Filters section.

x|
Ele Units
Item Total Dated Warning Time User Warning
Total Frinting time. | 2302 EEN
Wiper Blade [z0 EE B Reset | T -
Ficller Blade J2302 J20/06.15 J1000 Fleset | ¥
Filters
M1 Fine Fiter [0 ELE B Resst |
t42 Firte: Fiter [0 [zz05ne | |15 Rresst | ~
M3 Fire Filter [0 ELE B Rieset | ~
#4 Firne: Fiter [0 [zz05ne | |15 Freset ¥
M Fine Filter [ [kwmne 5 |1 Resst ) |
ME Firne: Fiter [o [zzsne (i Fresst | ¥
General Pumps
Purge Unit Pume — [2302 [z0/0e15 | 3500 Fresst | r —
Fioller dirt Pump 2424 Ja0vnB/15 3500 Reset | r
Purge Unit Pump Tubef115 J17/05./16 J1500 Fieset | ¥
Rollr Ditt Pump Tube [555 B [ED Resel | ~
Print Heads
=

Save |

Figure 4-126 Maintenance Counters screen, showing material filters

The figure above shows that five hours of filter time have passed since filters
were installed in the M5 slot location.

%{ Factory-installed filters for Vero PureWhite are in the M5 slot location.

To prepare for material filter replacement:

1. Prepare the following tools and materials:

O 8-mm hex (Allen) key

O protective gloves

O cleaning cloths or paper towels

O replacement filter or twin-filter kit (supplied in the Start-up Kit)
2. Close the printer application.
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3. Shut down the printer computer, wait 60 seconds after the monitor goes
blank, and turn off the main power switch.

Caution:

The monitor goes blank before the computer shuts down. Turning off the
printer before computer shutdown can cause damage.

4. Using an 8-mm hex (Allen) key, open the two latches that secure the back
of the materials cabinet and remove the back of the cabinet.
5. Locate the Vero PureWhite filter/filters.

In some printers, one filter is installed on the Vero PureWhite line. Other
printers have a set of twin filters.

Figure 4-128 Twin material filters installed

6. Continue with "Replacing a Single Filter" on the next page or "Replacing
Twin Filters" on page 4-85.
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Replacing a Single Filter

1. Put on protective gloves.

Warning: Toxic and Corrosive Materials

Prolonged contact with resins could cause skin irritation. Put on protective
gloves before continuing.

2. Disconnect the tube from the left (inlet) side of the material filter.

Important:

To disconnect the tube, hold the fitting at the end of the tube in place and turn
the filter. Otherwise, the tube will be twisted and material might leak.

3. Make sure that the tube fitting remains on the tube.

4. Wrap the filter in a cleaning cloth (or paper towel) to absorb material
spillage.

5. On the new filter, identify the side marked INLET.

Figure 4-129 INLET side of the filter
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6. Connect the INLET side of the new filter to the disconnected (left) tube.

Figure 4-130 INLET side of the filter connected to the left tube

Important:
To connect the filter, hold the fitting at the end of the tube in place and turn the
filter. Otherwise, the tube will be twisted and material might leak.

7. Disconnect the remaining tube from the old filter.

8. Discard the old filter.

Caution:
The filter contains uncured printing material. Discard the filter in accordance

with applicable environmental regulations.
9. Connect the free tube to the right side of the new filter.

Important:

Before connecting the tube to the filter, turn the filter about 90°. When
connecting them, hold the fitting at the end of the tube in place and turn the
filter back to its original position. Otherwise, the tube will be twisted after you

connect it, and material might leak.

10. Wipe the filters, tubes and surrounding area to remove material leaks and
spills.

11. Replace the back of the materials cabinet.

12. In the Maintenance Counters screen, click Reset and then Close (see
Figure 4-126 on page 4-81).
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Replacing Twin Filters

1. Put on protective gloves.

Warning: Toxic and Corrosive Materials

Prolonged contact with resins could cause skin irritation. Put on protective
gloves before continuing.

2. Detach the filter set from the bracket.

Figure 4-131 Detaching the filter set
3. Disconnect the filter set from the printer at both ends, and remove it.
Make sure that the fittings remain on the tubes in the printer.

4. Wrap the open tubes and the removed filter set with cleaning cloths (or
paper towels) to absorb material spillage.

5. Discard the old filter set.

Caution:
The filters contain uncured printing material. Discard them in accordance with
applicable environmental regulations.
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6. On the new filter set, identify the side where the filters are marked
INLET.

Figure 4-132 INLET side of the filter
7. Connect the INLET side of the new filter set to the tube on the left side.

Figure 4-133 Filter set attached on the left side

Important:

Before connecting the tube, turn the filter set towards you about 90°. When
connecting the tube, hold the fitting at the end of the tube in place and turn the
filter set back to the upright position. Otherwise, the tube will be twisted after

you connect it, and material might leak.

8. Connect the other side of the new filter set to the tube on the right side.
See the "Important” note above. Make sure that the tubes are not twisted
after connecting them.
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Replacing the
Odor Filter

Replacing the
UV Lamps
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9. Secure the filter set to the bracket.

Figure 4-134 Filter set secured to the bracket

10. Wipe the filters, tubes and surrounding area to remove material leaks and
spills.

11. Replace the back of the materials cabinet.

12. In the Maintenance Counters screen, click Reset and then Close (see
Figure 4-126 on page 4-81).

If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (as necessary) to keep your working
environment pleasant. This is normally done during the preventive-
maintenance service visit.

The UV lamps used for curing models have a long, but limited, working life.
You can test and adjust their effective power with the UV Calibration wizard .
If you need to replace a UV lamp, follow these instructions:

1. Make sure the printer is in offline mode.

Figure 4-135 Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

Warning
Before continuing, make sure that the safety interlock is not defeated, and that
the UV lamp is not hot.

2. Start the UV Lamp Replacement wizard from the Options menu.
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File” Options Help

Pattern Test
Dynaric Nozzle test

Wizards
Built In Tests...

Collect Service Data

Previous job last slice: 0

Go to Tray Upper Position F5

Go to Purge Position F6
Wipe F7
Go To Head Inspection F8

Go to Tray Lower Position

Execute Purge Sequence

Maintenance Counters...

Ctrl+Alt+B

Cleaning

Shift+ Ctrl+ C
F2

M1-L

400 gr
FullCure705

Material Replacement

Head Filling Calibration

UV Calibration
UV Lamp Replacement

19 Jul 2017

15:07

Cabinet B
FullCure705 FullCure705

SH-L

400 gr

Head Alignment
Head Optimization
Load Cell Calibration
Shutdown

SH-R

400 gr
Shift+ Ctrl+R
Shift+Ctrl+F
Shift+Ctrl+E

Shift+ Ctrl+U

Shift+Ctrl+L
Shift+ Ctrl+ D

Figure 4-136 Selecting the UV Lamp Replacement wizard

3. Make sure that the build tray is empty, and confirm this in the wizard

screen. Then, close the printer, and click Next.

S

-

UV Lamp Replacement Wizard

Check Printer

Confirm before continuing:

stratasys

[ The build tray is empty.

<72 Previous

Mext 2=

Figure 4-137 Tray confirmation
The axes move to the “home” position.

4. Select the UV lamp(s) to be replaced and click Next.

-

UV Lamp Replacement Wizard

Select Action

stratasys

[ Replace the right LY lamp.
[ Replace the left Y lamp.

DOC-08040 Rev.D

<72 Previous

Mext 2=

S

Figure 4-138 UV lamp selection screen
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5. Disconnect the UV-lamp power connector and the UV heat fuse
connector.

UV Heat Fuse

Conneclor

UV Lamp (5
Conneclor ~ -~

Figure 4-139 Disconnecting the UV lamp

Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover up
(B), then out (C).

Figure 4-140 Removing the UV lamp cover
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7.

0.

Pull the UV lamp reflector out of the UV housing.

Figure 4-141 Removing the UV lamp reflector

Inspect the new UV lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the reflector
opposite (not next to) the print block.

Note: Extra black strips are included in the printer Start-Up Kit. If necessary,
you can remove the black strip from the old reflector and install it in the new
reflector (as long as the black paint has not faded).

Discard the old UV reflector and lamp.

%{ Dispose of the used UV lamp in accordance with environmental and safety
requirements.

DOC-08040 Rev.D

Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.

Ventilate the room thoroughly.

Use protective gloves when collecting mercury and lamp components.
Remove spilled mercury with a method that prevents the generation of
mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container.
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10. Insert the new UV lamp/reflector unit into the housing, next to the print
block.

UV lamp UV lamp
assembly ———— e assembly

Black slrip‘——{ . ;——Black strip

Figure 4-142 Print block and UV lamp assembly, showing correct
placement of black strip

11. Replace the UV lamp cover by inserting it into the slot on the bottom of
the housing, and tighten the securing screw on top.

Figure 4-143 Replacing the UV lamp cover

12. Reconnect the power and heat fuse connectors.

UV Heat Fuse
Conneclor

-I\h

Conneclor

i‘l
R
UV Lamp ‘LQ

Figure 4-144 Connecting the UV lamp
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13. In the wizard screen, confirm that you have replaced the UV lamp(s) and
that the black strip is attached, then click Next.

UV Lamp Replacement Wizard

Restore Printer

Confirm before continuing:

[ The selected L% lamps were replaced.
[ The black strip iz positioned comrectly (see Help).

stratasys

Figure 4-145 UV-installation confirmation
The wizard operates the UV lamps and checks if their power is within the
acceptable range for each printing mode.

UV Lamp Replacement Wizard

Warming UV Lamps

Gﬁ LN larmp(s) warming up. This takes about 4 minutes.

stratasys

Figure 4-146 Status during UV lamp check

After replacing a UV lamp, it is recommended that you calibrate its power
for the various printing modes. The next screen allows you to continue to
the UV Calibration wizard (see "Testing and Calibrating the UV Lamps" on

page 4-65).

UV Lamp Replacement Wizard

Select Action

@ Fun the LY Calibration ‘wizard now.

1 End the wizard.

stratasys

Figure 4-147 Calibration selection screen
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Built-in Tests

The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting,.

Because running the tests affects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing.

The test suite features:

« The organization of printing-related tasks in categories:
O Communications

O Data cards
Temperatures
Voltages

Encoder repeatability

aaaaq

Print-head heating
O Print-head filling
« A clear display of test results and the source of any failures, enabling you
to determine if printing is possible or worthwhile.
« The ability to monitor test results for specific components.
« Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and

software. A large number of hardware defects (or near-defects) warns you of
possible printing problems, either for current or future jobs.

%{ Stratasys recommends running the built-in tests in the following cases:

DOC-08040 Rev.D

« as aroutine test, once every two weeks
« as asystem check, before major (long) jobs
« as needed, for troubleshooting

To open the Built-in Tests screen, do one of the following:

» From the Options menu, select Built-In Tests.
* Press Ctrl+Alt+B.

ntions Help
o Go to Tray Upper Position F5
Str‘ Go to Purge Position FG
Wipe F7
Go To Head Inspection F&
Go to Tray Lower Position F10
Execute Purge Sequence F4
. Pattern Test F3
Dynamic Mozzle test
. Wizards »
Built In Tests... Ctrl+Alt+B

Maintenance Counters...

- Collect Service Data F2

Figure 4-148 Selecting Built-In Tests from the Options menu
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Test List
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The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

-

Built In Tests
Test Name Group Statuz  Errar Description i
O FIFO Norenterupt Test Data Card ?
O FIFD Interrupt Test Data Card ?
O Swstem Info Erwironment ?
O Paramemeter 5 anity Check. Pararmeters ?
OFrFID RFID K
O 5ub-System Commurications Commuricat... ? L
[ Cabin Temperature General ? 3
[0 Head EEPRDMs Head Cards 9
[ Head Valtages Head Cards ?
[ Head/Black Heaters Heaters ? Summary
O 5vstem Voltages Syztem Yol ? ?
O Interlock Interlock ?
O Uy Lamps Lamps ?
[ Ases Limits Motears ?
[ Elock Filling Filling ? i
[ I i - - . — i L |
4 fr 3
Teszts Selection =
Group Selection Set "’E Help
| &l | | MNane | |Unknu:|wn| |--None = v| |--None = v| —
3L Close

Figure 4-149 Built In Tests screen

Test Name

This column lists all of the tests, together with selection check boxes.
Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group drop-down list at the bottom of the
screen.

Group

This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
drop-down list at the bottom of the screen.

Status

This column shows the results of each test after you run it:

V' Test successfully completed.
X Test failed. (Double-click on afailed test’s line to review the failure details.)

7 Unknown results. (The test has not been run yet.)
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Test Selection Area

In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.

None Click to de-select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).

Group Use this menu to select tests by component category.

Selection Set | Use this menu to select a pre-configured set of tests to run at
specified times (computer startup, before printing, etc.).

Running Built-in - To run the selected tests:

Tests

After you run a test, the Save and View command buttons are added to the
Built In Tests screen.

Test Results To save and view a report of all tests:

Summary

X

‘:8 Help

R Close
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> Use the Save and View command buttons.

Click the command buttons, on the right side of the screen to perform the
following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to

Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as an
HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files are
saved in the J750 installation folder, but you can save it in any other folder.

View

Click to display the latest test report that you saved. (You can view other test
reports by opening the relevant files in your Web browser. To do so, open
Windows Explorer, and double click the BITReport file.)
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Close

Click to close the Built-in Tests screen.

Summary

On the right side of the screen, a symbol represents the combined results of

all the tests run, using the symbols from the Status column.

v All tests successfully completed.

X At least one test failed.

7 Not all tests performed.

Test
Descriptions and
Troubleshooting

The following table lists the name of each test in the Built-in Tests suite,
together with its description and a possible reason for its failure. If you need
assistance, contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
Sub-System Tests communications between « Disconnected communications
Communication components. cable.
+ Faulty cable.
FIFO Non-Interrupt/ | « Tests the data queue in the « If both FIFO tests fail:
FIFO Interrupt DATA PCI card. Faulty DATA_PCI card.
» Tests the Windows interrupt. + If only the FIFO Interrupt test fails:
Faulty Windows interrupt.
Encoder Tests the encoder's reliability by Faulty encoder.
comparing readings from multiple
runs along the X-axis.
System Info Compares the following parameter | Failure of RAM memory allocation in
values with the minimum the printer computer.
requirements.
+ physical memory
 available memory
» free space on disk
* monitor resolution
RFID Verifies the presence of RFID tags + Faulty RFID reader.
on all loaded material cartridges, and | Faulty RFID reader power supply.
tests them by writing to and reading I
» Faulty or misaligned RFID tag.
from each one. ] . )
» High level of electromagnetic noise
around the RFID tag.
System Voltages Checks if the following voltages are + VPP power supply:
within 5% of the required voltage: Faulty head drive(s).
40V to the print heads by the VPP| * VDD power supply:
power supply Faulty height thermistor(s).
* 12V to the height thermistors by
the VDD power supply
Block Filling Analyzes the thermistor readings Faulty thermistor.
when the block is full and when it is
empty.
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Test Name

Description

Possible Reason for Failure

Interlock

Tests the interlock in the printer
cover.

 Failure of interlock mechanism.
+ Faulty latch.
* Disconnected cable.

Cabin Temperature

Tests the temperature level in the
build-tray area.

Faulty temperature sensor (OHDB).

supplied to the print heads.

Head EEPROM Tests the read/write capabilities of | Faulty print-head driver card(s).
the print-head driver cards.
Head Voltage Checks the control of voltages Faulty print-head driver card(s).

Head/Block Heaters

Tests the heaters in the print heads
and in the print-block body.

Faulty heaters or thermistors.

block.

UV Lamps Tests each UV lamp at the High Faulty UV lamp.

Quality power level.

yp Faulty UV power supply.
Disconnected UV cable.

Axes Limit Tests the hardware and software Faulty hardware sensors.

limits of all axes. Wrong Max Position parameter.
Parameter Sanity Compares the values of all printer One or more of the printer parameters
Check parameters (in cfg files) to the is not within the required range.

required values. Details appear in the BIT report.
Vacuum Tests the vacuum level in the print

» Faulty vacuum sensor.
* Vacuum leakage.
* Wrong parameters.

DOC-08040 Rev.D
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Replacing the  Printer waste contains partially cured polymeric material, collected during

Waste normal operation and maintenance of the printer. For safety and
Container environmental reasons, this material is kept in a special leak-proof, disposable
container.

The container has a capacity of 10 kilograms of waste material—usually
enough for several months of printer use. The printer application displays a
warning message when there are 9 kilograms of material in the container,
and stops the printing when the net weight reaches 9.5 kilograms. Above 9
kilograms, the software does not allow you to start a printing job or activity
until you replace the waste container. You can monitor the weight of the
waste container in the Printer Indicators display in the printer interface. You
can also visually inspect the level of waste in the container. To access it, see

page 4-99.
To monitor the waste weight (and other indicators) in the printer:

> In the main printer interface screen, click the display toggle to view the
printer indicators.

140ct 2015 11:20

Heads (°C)

Heads Liquid SO0

Waste (gr)

Ambient(°C) [ CEGERVETSIT ]

UV Lamps n Pre Heater

Display toggle ——¥ STRATASYS J750™

button

Figure 4-150 Printer interface, showing waste weight (red background
indicates operator alert)
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The waste container consists of a plastic container inside a cardboard box.
You typically dispose of the entire waste container—including the box.
Therefore, you must assemble a new box and insert a new plastic container
before you can install it in the printer.

Replacement boxes, plastic containers, and sealing caps are supplied in the
J750 printer start-up kit and in the preventive-maintenance kit.

To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Place a new plastic container into the box.

Note: Do not close the box until you connect the waste drain tube from the
printer.

To replace the waste container:

1. Locate the door on the lower-left side of the printer.

2. Push in the top-center of the door to release the latch and open the door.

Figure 4-151 Accessing the waste container
3. Carefully slide out the waste container to remove it from the printer.
4. Place the new waste container next to the full container.

5. Unscrew the cap securing the waste drain tube and connect it to the new
container.

6. Close the full container with the cap supplied with the new waste
container.

7. Close the new waste container box.
If necessary, use tape to hold it closed.

8. Position new the waste container inthe printer.

Note: Make sure that the waste drain tube is not crimped and that it is not
pinched by the container.

9. Close the waste compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.
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Cleaning the The painted exterior plastic panels of J750 3D printers have a durable finish,
Exterior Panels offering excellent chemical resistance to common cleaning materials. Follow
the recommendations below when cleaning these areas of the printer.

Acceptable Cleaning Agents
« mild soap solution
« common household cleaners and window cleaners
« common commercial and industrial detergents, 5% solution in water
« alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Unacceptable Materials

« industrial solvents

« cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

« spray disinfectants
« abrasives and agents which could wear away the panel finish

DOC-08040 Rev.D 4-100



Handling Printed Models

Removing Models After Printing .................................... 5-2
Removing the Support Material ..................................... 5-2
Post-Printing Treatment for Models Made with VeroClear 5-5

Photo-Bleaching Instructions ....... ... ... ................... 5-5
Storing Models ... 5-6

DOC-08040 Rev. D

5-1



Stratasys J750 User Guide 5 Handling Printed Models

Removing Models After Printing

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on the
printer, it is best to let the printed models cool in the printer, with the cover
closed, as long as possible.

If the printer must be used to produce additional models as soon as possible:

1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or spatula
(supplied in the tool kit), taking care not to pry or bend the model.

& Warning:

Wear protective gloves when handling printed models before they are
washed.

3. Place the models on a flat surface, and cover them with a cardboard box
or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

After printed models have cooled, the Support material must be removed.
This can be done by different methods, depending on the type of Support
material, the size of the model, how delicate it is, the amount and location of
the Support material, and other factors. Use the following methods as a guide,
and adapt them (or a combination of them) for finishing the models you are
handling.

There are two types of Support material available:

» SUP705 (FullCure705), a gel-like Support material.

« SUP706, an easily removed Support material that dissolves in a solution of
caustic soda and sodium metasilicate.

SUP705 (FullCure705) and SUP706 can be removed from printed models
using the following methods, in this order:

1. by hand
2. water pressure (in a suitable cleaning unit)

3. SUP705: 1% caustic soda solution (recommended for a smooth finish)
SUP706: 2% caustic soda and sodium metasilicate solution
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Removing While wearing protective gloves, break away excess Support material on the
Support Material outside of the model. For delicate models, use a toothpick, pin or small brush

by Hand after dipping the model in water.

« For SUP705, after breaking away excess Support material, soak the model
in a 1% caustic soda solution (see "Removing SUP705 with Caustic Soda"
on page 5-4).

« For SUP706, after breaking away excess Support material, soak the model
in a 2% caustic soda and sodium metasilicate solution (see "Removing
SUP706 with Caustic Soda and Sodium Metasilicate" on the next page).

Removing For most models, the most efficient way to remove Support material is by
Support Material using a high-pressure water jet. One suitable system is the Balco WaterJet
with Water cleaning unit. This device is marketed by Stratasys.

Pressure
@ e o | ™
Powel  fme  Ligh ON —Ir?
| |:- ' ,'. \I ||l
| r
] |
| |' ljt——‘ |
B <
| KV U
e ol /‘T

-

Figure 5-1 Balco WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump turns
ordinary tap water into a high-pressure jet, and a wiper keeps the window

clear.

Use caution when cleaning delicate models with high-pressure water

systems.

DOC-08040 Rev.D 5-3



Stratasys J750 User Guide

Removing
SUP705 with
Caustic Soda

Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to
remove Support material from difficult-to-reach areas and to give the model a
smooth, clean finish. The amount of time you soak the model in the solution
depends on how delicate it is and how much Support material needs to be
removed, but it is typically between half-an-hour and several hours. In any
case, you should remove as much Support material as possible before the
caustic soda treatment, and rinse the model thoroughly (with a water jet)
afterwards.

& Warning

Removing
SUP706 with
Caustic Soda

and Sodium
Metasilicate

%

T\
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Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into caustic soda. When diluting the solution, always add caustic soda to
water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and models soaked in it.

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) and
sodim metasilicate (Na,SiO,) to remove Support material. The amount of
time you soak the model in the solution depends on how delicate it is and

how much Support material needs to be removed. Rinse the model
thoroughly under running water afterwards.

SUP706 will dissolve into the caustic soda and sodium metasilicate solution
and saturate it, reducing its effectiveness. Replace the solution when the
Support material reaches 15% of the solution (after approximately one month
of average use).

Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into caustic soda. When diluting the solution, always add caustic soda to
water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and models soaked in it.
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Post-Printing Treatment for Models Made with VeroClear

Models made with VeroClear (RGD810) have a slight yellow tint when
removed from the printer. This is especially true for models printed with a
glossy finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.

As a rule, best clarity is achieved when parts are printed with a matte finish,
and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

ELW»\YW

&

Figure 5-2 Left: lllumination chamber; Right: Desk lamps

Photo- Follow these instructions for photobleaching printed models.
BIeaCh'r]g « The fluorescent lamps should be rated 45W, 6500K.
Instructions

» When using desk lamps, place the models in a container lined with
aluminum foil. Use at least two lamps, more when treating models in a
large container.

« Arrange the models with enough space between them to allow light to
reach all sides of each model.

« Verify that the ambient temperature around the models is approximately
40°C (104°F). Higher temperatures may cause model distortion; lower
temperatures may not produce satisfactory results. When using desk
lamps, you can achieve the required temperature by positioning the lamps
approximately 10 cm (4 in.) above the models.

« Inspect the models after six hours of treatment.

O For parts with a matte finish, this should be enough. Polish and
lacquer the parts.

O For parts with a glossy finish, continue the photobleaching treatment
for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately 70%
within six hours. After 24 hours, tint was reduced by approximately 90%.

More information about this treatment is available in the application note
VeroClear RGD810 Model Material.
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Storing Models

Models are cured as they are printed, making them safe and stable for a long
time. However, proper storage conditions are necessary to prevent deforming.

« Keep printed models at room temperature and in a low-humidity
environment.

« Do not expose models to direct sunlight and other heat sources.
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